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    USGS Center for EROS 
    Sioux Falls, SD 
Overview 
 
The monitoring of wide area hydrologic events requires the manipulation of large 
amounts of geospatial and time series data into concise information products that 
speak to the location and magnitude of the event. To perform these manipulations, 
scientists at the US Geological Survey’s Center for Earth Resources Observation and 
Science have implemented a hydrologic modeling system. The system consists of a 
data assimilation component which generated data for a geospatial stream flow model 
(GeoSFM) that is run operationally to identify and map wide-area stream flow 
anomalies. GeoSFM integrates a geographical information system (GIS) for 
geospatial preprocessing and post-processing tasks and hydrologic modeling routines 
implemented as dynamically linked libraries (DLLs) for time series manipulations. 
Model results which include daily maps depicting the status of stream flow and soil 
water conditions are disseminated through a variety of media including Internet map 
servers and flood hazard bulletins. 
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 ks   geosfm.avx  v1.0     GeoSFM Training 
  maxcover  geosfm.dll          Manual 
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 soildepth  geosfmgzip.exe     GeoSFM Technical  
 texture   geosfmpost.exe              Manual 
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    geosfmtar.exe        
    install.bat  
  
   
 
 
 Grids   Shapefiles  Text files  Text files 
 basins   basply1.shp  actualevap.txt  localflow.txt 
 downstream  rivlin1.shp  balfiles.txt  logfileflow.txt 

elevations  limpbas.shp  balparam.txt  logfilesoil.txt   
 flowacc   gauges2.shp  baseflow.txt  mssbalance.txt 
 flowdir      basin.txt   maxtime.txt  
 flowlen      basinrunoffyield.txt obsflow.txt  
 hilllength     cswater.txt  order.txt 
 outlets   Project   damlink.txt  rain.txt   
 slope   project.apr  damstatus.txt  rainstations.txt 
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 strlinks      evap.txt   response.txt 
 traveltime     evapstations.txt  river.txt 
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       forecast3.txt  soilwater.txt 
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       initial.txt  times.txt   
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evapdata raindata 
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demdata landcov 
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Above is a list of all data files contained on the GeoSFM CD.  The GeoSFM Users Manual is accompanied by the 
GeoSFM Training Manual and the GeoSFM Technical Manual.                         

1.0 GeoSFM Setup 

 
Model Overview 
GeoSFM was developed by scientists at the USGS Center for EROS in Sioux Falls, SD. The 
development of the model was driven by the need to establish a common visual environment for the 
topographic analysis, data assimilation, time series processing and results presentation activities that 
go into the monitoring of hydrologic conditions over wide areas. Many of the datasets involved in 
these processes are raster grids. The spatially distributed nature of the raster grids used in these 
processes pointed to the adoption of a customizable geographic information system with excellent 
raster functionality. The ArcView 3.x GIS series was adopted for the implementation because it 
provided a visual, customizable development environment with excellent support of raster 
operations. An ArcView extension was developed (in Avenue) for the geospatial processing 
operations and for the initiation of time series analysis tasks. Routines for performing the 
hydrologic computations involved in mass balance and routing were developed in a mixed 
programming environment (C/C++ and Visual Fortran) and compiled as dynamically linked 
libraries (DLL). These DLLs are called up directly from within ArcView scripts thus eliminating 
the need to develop a separate interface for hydrologic routing operations.  
 
Specific data values referenced in this document are related to the exercises outlined in the 
GeoSFM Training Manual.   
 

1.1 Model Installation 

 
Files Description 
geosfm.avx  v.1.0 Geospatial Stream Flow Model (GeoSFM) ArcView Extension 

model. The model interface. 
Geosfm.dll Geospatial Stream Flow Model – Dynamically Linked Libraries 

(.dll.) Hydrologic (water balance and routing) component. 
Geosfmcalib.exe Geospatial Stream Flow Model Calibration – Calibration module. 
Geosfmgzip.exe 
geosfmtar.exe 

GeoSFM Utilities – Freeware used for unzip and tar of 
downloaded files. 

Geosfmpost.exe Geospatial Stream Flow Model Calibration – Calibration module. 
Geosfmstats.dll Geospatial Stream Flow Model – Dynamically Linked Libraries 

(.dll.) Used for time series analysis. 
INSTALL.bat Copies all GeoSFM files and registers the .dll files to the local 

computer. 
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1.2 Complete Terrain Analysis 

The analysis of topographic data for hydrologic modeling applications relies on the simple principle 
that water flows in the direction of steepest descent. Hence by comparing the elevation of a given 
cell with that of the eight surrounding cells, it is possible to determine which direction incident 
drops of water would flow. Flow direction in GeoSFM is assigned using the eight direction pour 
point model in which each grid cell is assigned one of eight compass directions depending on which 
of its eight neighboring cells it discharges flow into.  

 
The computation of a flow direction grid paves the way for the determination of other parameters of 
hydrologic interest such as upstream contributing area, distance to the basin outlet and the slope of 
the land surface. It also allows for the definition of hydrologic modeling units such as catchments 
and river reaches. Routing parameters are extracted for each of the resulting catchments and river 
reaches from the data derivatives of terrain analysis as well as the soil and land cover datasets. The 
extracted parameters are stored in ASCII files formatted to GeoSFM specifications. For any given 
river basin application, the terrain analysis only is performed once during the model creation phase. 
The GIS data layers and ASCII files resulting from the analysis are stowed away for use in future 
flow simulations.  
 

1.2.1 Elevation Processing 

The direction and rate of movement of water over the land surface is influenced very heavily on 
underlying topography. In this age of digital geocomputation, the digital elevation model (DEM) 
has consequently become the single most important input in the setup of hydrologic models. The 
division of river basins into catchments with associated river reaches, and the parameterization of 
these modeling units from DEM data have been automated in many hydrologic models including 
GeoSFM. While the model supports the use of DEMs of any resolution, the 1-kilometer resolution 
Hydro1k DEM produced at the U.S. Geological Survey’s Center for Earth Resources and 
Observation Science (EROS) is used in GeoSFM because of its global coverage. Hydro1K is a 
hydrological corrected DEM which implies that it is devoid of spurious pits that interrupt hydraulic 
connectivity over the land surface. These pits are artifacts of the interpolation procedure used in the 
creation of DEMs, and they result in breaks in the flow network unless they are removed. Hydro1k 
data for the whole world are available for download over the Internet at 
http://edcdaac.usgs.gov/gtopo30/hydro/.  
 
Elevation Input Data 
Input Grid Description Unit 
elevations Hydrological corrected Digital Elevation Model – 

source HYDRO1K DEM 
meter 

 

32 64 128 
16  1 
8 4 2 

64
128 32

1 

2 
4 

8 

16
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Downloading/Correcting HYDRO1K DEM 
 
The GeoSFM uses a digital elevation model for the delineation of hydrologic modeling units.  The 
HYDRO1K is used in the training exercises in the GeoSFM Training Manual because of its 
availability. The download process documented below captures data needed to complete exercise 
one outlined in the GeoSFM Training Manual.  This exercise was developed for the Limpopo Basin 
in southern Africa.  
 
These data are available from the U.S. Geological Survey’s Center for Earth Resources Observation 
Science (EROS) at http://edcdaac.usgs.gov/gtopo30/hydro/africa.html. This website will bring you 
to the Land Processes Distributed Active Archive Center page, from this page scroll down to the list 
of downloads. (Data for other regions is found at the following website 
http://edcdaac.usgs.gov/gtopo30/hydro/.)  
  
 

 
 

                       

The African HYDRO1k can be downloaded in its entirety or individual layers can be downloaded by selecting 

the data layer above. Detailed descriptions of the techniques used in the development of the HYDRO1k data 

set can be found in the Readme file. 

Download the entire HYDRO1k data set for Africa as a tar file (215.5 MB) 
 

 Download HYDRO1k DEM for Africa as a tar file (34.0 MB) 
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 Click on –Download HYDRO1k DEM for Africa as a tar file (34.0MB).  Save the file to 
your workspace, c:\GeoSFM\workspace. Use WinZip to select and extract all files to your 
workspace. Extract the af_dem.bil from the af_dem.bil.gz file.  If you do not already have WinZip 
installed you can download a free trial version from http://www.winzip.com/winzip/download.htm. 
Extracted files: 

• af_dem.gz 
o af_dem.bil 

• af_dem.blw 
• af_dem.hdr 
• af_dem.stx 
• readme.af 

 
Next, you need to add the Dem data to the ArcView project and correct/convert into a grid for use 
in exercise one as outlined in the GeoSFM Training Manual. 

Add the Digital Elevation Model to the View using Add Theme button  from the View menu.  
Change the Data Source Types to Image Data Source.  Click on the af_dem.bil file from the 
c:\GeoSFM\workspace directory and click OK to add the DEM to the View.  

 
 
Next, the DEM will need to be converted to a grid.  Select the theme Af_dem.bil so that it appears 
in a raised box.  Checking the little box next to the theme name will make it visible.   
 
From the Theme menu select Convert to Grid… 
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The Convert Af_dem.bil dialog box appears.  Navigate to the c:\GeoSFM\workspace directory 
and name your new grid Af_dem_grid in Grid Name.  Then click OK. 

 
 
A dialog box appears asking if you would like to Add grid as theme to View.  Click Yes. 

 
New Af_dem_grid theme shown below. 
 

 
After adding the grid to the View you will need to perform some map calculations to produce a 
corrected elevations grid. The high values are introduced into the DEM to avoid having to store 
negative values in the .bil format. To correct the DEM, you need to run the following 3 calculations.  
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From the Analysis menu choose Map Calculator… 

 
The first correction subtracts 65536 from all the cells with elevation higher than 32768, which 
restores the original negative values. The result of this computation is that all NODATA cells are 
assigned values of -9999 while all other cells will have their true elevation (negative or positive). 
 
In the Map Calculator type the following expression exactly as shown: 
( [Af_dem_grid] >= 32768).con( [Af_dem_grid] – 65536, [Af_dem_grid] ) 

 
Then click the Evaluate button. 
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This produces a temporary grid called Map Calculation 1, seen below. 

 
 
Choose the Map Calculator from the Analysis menu again to do the second calculation.  The 
second calculation assigns values of zero to NODATA cells and values of one to all other cells so 
that the NODATA cells can be eliminated in the final step.  Type in the following expression 
exactly as shown:   
( [Map Calculation 1] = -9999 ).con (0.AsGrid, 1.AsGrid) 

 
Then click the Evaluate button. 
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This produces a temporary grid call Map Calculation 2, seen below. 

 
  
The final computation divides the result of the first correction with the result of the second 
correction. Zero divides values of -9999 while 1 divides all other values. Division by zero results in 
a NODATA cell being created while division by 1 leaves the original value unaltered.  Choose the 
Map Calculator from the Analysis menu again and type in the following expression exactly as 
shown:   
( [Map Calculation 1] / [Map Calculation 2]) 
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Then click the Evaluate button. 
This produces a temporary grid call Map Calculation 3, seen below. 

 
 
 This will be the final elevations grid that you will use for the rest of the exercise, so you need to 
make it permanent. Select the Map 3 Theme so it appears in a raised box, from the Theme menu 
select Save Data Set…  

  
 
In the Save Data Set Dialog Box navigate to the c:\GeoSFM\workspace directory and name your 
new grid Elevations in the Grid Name field.  Then click OK. 
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You can now remove all themes by selecting the theme so it appears in a raised box, and then from 
the Edit menu select Delete Themes. 

 
 

Now the permanent Elevations grid can be added to the View using the Add Theme button .  
You are now ready to begin processing the elevation in section 1.3 of the GeoSFM Training 
Manual. 
 
 

1.2.2 Defining Basin Extent 

 
 
Analysis Extent Input Data 
Input Shapefile Description  
Limpbas.shp Shapefile defining analysis extent   
 
Analysis Environment Input Data 
Input Parameters Description Unit 
Analysis Extent Boundary defined for analysis area –same as 

Limpbas.shp  
meter 

Analysis Cell Size Boundary defined for cell area –same as elevations   
Stream Delineation 
Threshold 

Minimum number of cells upstream of a given 
location for initiating stream.    –default 1000–
min500 

cell 

 
 
Downloading/Processing Basin Extent 
 
The GeoSFM uses a shapefile to define the analysis extent for use in the modeling process.  
HYDRO1K Basins data sets are derived using the vector stream networks along with the flow 
direction data set. Each polygon in the basin data set has been tagged with a Pfafstetter code 
uniquely identifying each sub-basin.  Additional attributes defining the characteristics of each sub-
basin have also been developed. These data are available in an ARC/INFO export format and 
shapefile format.  The download process documented below captures data needed to complete 
exercise one outlined in the GeoSFM Training Manual.  This exercise was developed for the 
Limpopo Basin in southern Africa.   
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These data are available from the U.S. Geological Survey’s Center for EROS at 
http://edcdaac.usgs.gov/gtopo30/hydro/af_basins.asp.  (Data for other regions is found at the 
following website –http:/edcdaac.usgs.gov/gtopo30/hydro/.)  
 
This website will bring you to the Land Processes Distributed Active Archive Center page; scroll 
down to the list of downloads. 
 

 
 

                       
 

The African HYDRO1k can be downloaded in its entirety or individual layers can be downloaded by selecting 

the data layer above. Detailed descriptions of the techniques used in the development of the HYDRO1k data 

set can be found in the Readme file. 

Download the entire HYDRO1k data set for Africa as a tar file (215.5 MB) 
 

 Download HYDRO1k Basins data set for Africa as a tar file in ARCINFO export format (7.4 MB) 

 Download HYDRO1k Basins data set for Africa as a tar file in shapefile format (7.4 MB)  
 

  Click on –Download HYDRO1k Basins data set for Africa as a tar file in shapefile 
format (7.4 MB).  Save the file to your workspace, c:\GeoSFM\workspace. Use WinZip to select 
and extract all files to your workspace. Extract all files from the af_base.tar.gz file.  If you do not 
already have WinZip installed you can download a free trial version from 
http://www.winzip.com/winzip/download.htm. 
Extracted files: 

• af.readme 
• af_bas.dbf 
• af_bas.prj 
• af_bas.shp 
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• af_bas.shp.xml 
• af_bas.shx 

 
Next, you need to add the Basin data to the ArcView project and select the basins you will need for 
your area. In this example you will select the basins needed to complete exercise one outlined in the 
GeoSFM Training Manual.   

Add the Basin data to the View using Add Theme button  from the View menu.  Change the 
Data Source Types to Feature Data Source.  Click on the af_bas.shp file from the 
c:\GeoSFM\workspace directory and click OK to add to the View.  
 

 
 
After you have added the shapefile you will select the basin area by the Pfafsteller code in the 
attribute table.  Open the attribute table by clicking on the Table icon. 
 

 
 
From the Table menu select Query. 

 
 
The Attributes of Af_bas.shp query box opens.  
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 Double click on Level 2 under Fields.  Make sure the Update Values box is checked so all Level 2 
values will display under Values. Click on the “=” button and then on the value you need for this 
basin, we will select 54 for this exercise.  Click New Set. 

 
([Level2] = 54) 
  
All attributes with a value of 54 in the Level2 column will highlight yellow.  The African shapefile 
will also show the sub-basins selected highlighted in yellow. 

 
 
Now you can convert the selections to a shapefile, from the Theme menu select Convert to 
shapefile. 
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The Convert Af_bas.shp dialog box opens.  Navigate to the appropriate directory and under File 
Name type in the name of the new shapefile. Click OK. 
 

 
The “Add shapefile as theme to the view?” dialog box will display, click Yes. 
 
Below the new shapefile is displayed. 

 
 
 
The shapefile can be added to the View when prompted during the Processing Elevation Data 
process in section 1.3 in the GeoSFM Training Manual. 
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1.2.3 Outputs from Terrain Analysis 

 
Stream/Basin Output Data 
Output Grids Description Unit 
FlowDir Flow direction grid consists of numeric values 

assigned using the eight direction pour point model. 
Each cell is assigned one of eight compass 
directions. 

Cell 

FlowAcc Flow accumulation grid defines the number of 
contributing cells draining into each cell. Values 
range from 0 at topographic highs to large numbers 
at the mouths of rivers. 

Number of 
cells 

FlowLen Downstream flow length grid defines the distance 
from the cell to the basin outlet. 

meter 

Streams Stream grid defines stream cells. 
Value 1 = stream, Nodata = land 

 

StrLinks Stream link grid assigns a unique value to each 
stream ID. 

 

Outlets Outlet grid defines number of outlets; one outlet per 
sub-basin, each outlet assigned a unique value.  

 

Basins Sub-basin grid assigns a unique ID value to each 
sub-basin. 

 

HillLength Hill length grid defines distance to stream, from 
cell to nearest stream. 

meter 

Slope Hill slope grid describes the maximum change in 
elevation between each cell and its eight neighbors. 
Expressed in percentage. 

 

Downstream Downstream grid assigns a unique ID number of 
the sub-basin immediately downstream. 

 

BigBasins Basin boundary polygon.  
Basply.shp Shapefile defining all sub-basins with unique ID 

and gridcodes. 
 

Rivline.shp Shapefile defining streams with unique IDs, 
gridcodes and from_node and to_node. 
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1.3 Generate Basin Characteristics File  

1.3.1 Soil Characteristics Processing 

 
The response of a river basin to a rainfall event depends very heavily on the nature and condition of 
underlying soils. In hydrologic models, soils are characterized through a combination of static 
parameters (e.g. texture, hydraulic conductivity) and dynamic parameters (soil moisture). In 
particular, GeoSFM requires a number of parameters including soil water holding capacity in 
millimeters, hydrological active soil depth in centimeters, texture, and average saturated hydraulic 
conductivity in meters per hour, Soil Conservation Service (SCS) runoff curve number and 
percentage of impervious cover. The Digital Soil Map of the World (DSMW) CD-ROM produced 
by FAO (United Nations Food and Agriculture Organization) and UNESCO (United Nations 
Educational, Scientific and Cultural Organization) is one data set used in this study because it is the 
finest resolution soil database with global coverage available. The Digital Soil Map of the World 
consists of ten map sheets covering Africa, North America, Central America, South America, 
Europe, Central and Northeast Asia, Far East, Southeast Asia, and Oceania. Each map sheet is 
available in three different formats including one vector format (ARC/INFO Export) and two raster 
formats (ERDAS and IDRISI). All the data are in geographic projection and are produced from 
original map sheets with a scale of 1:5 000 000.   

The Zobler data set is also used for calculating soil characteristics.  The data sets can be 
accessed from FTP site –ftp://daac.gsfc.nasa.gov/data/inter_disc/hydrologh/soil/.  Soil type and soil 
texture were constructed from Zobler. When combined with the DSMW data set (Zobler, 1986) 
there is improved model performance because of an enhanced variability in soil properties.   

The NASA Technical Memorandum 4286, A Global Data Set of Soil Particle Size 
Properties, published in 1991, was also used. The authors of this manuscript are Robert S. Webb, 
Cynthia E. Rosenzweig, and Elissa R. Levine.  This data set specifies the top and bottom depths, 
and the percentage of texture type (sand, silt, and clay) of soil horizons in 106 different soil types 
cataloged for nine continents.  The soil profile depth data set used was constructed by Webb.  
 
 
Soil Characteristic Input Parameters 
Input Grids Description Unit 
Rcn SCS runoff curve number grid uses hydraulic soil 

classes together with the GLCC classes to derive a 
RCN value. 

 

Whc Soil water holding capacity grid is calculated from 
the DSMW soil class and the total available water 
median soil moisture value. 

mm 

Soildepth Hydrological active soil layer depth grid created 
from DSMW soil code value and Webb’s soil depth 
values.  

cm 

Texture Texture grid created from Zobler’s seven classes 
converted to three classes –coarse, medium, and 
fine. 
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Input Grids cont. Description Unit 
Ks Saturated soil hydraulic conductivity grid created 

on Ks values, which are based on Zobler’s texture 
classes. 

cm/hr 

maxcover Maximum impervious cover grid based on wetland 
areas and water bodies found in the GLCC data set 
and stream cells defined in the flowacc grid.  

 

 
 
 
Soil Characteristic Data Sources 
 
Soil Depth 
 
Soil depth value source– NASA Technical Memo 4386 - 1991 
Titled: A global Data Set of Soil Particle Size Propeties 
Authored: Robert S. Webb, Cynthia E. Rosenzweig, and Elissa R. Levine 
Table 5 - Soil thicknesses for 106 soil types, 9 continents (cm) pg. 21 
 
Soil Code source - Digital Soil Map of the World (DSMW) CD-ROM 
FAOSOIL\DATA\AFRIC1.DAT & AFRIC2.DAT 
 
 
Texture 
 
Texture class source – NASA Technical Memo 87802 – 1986 
Titled: A world soil file for global climate modeling 
Authored: L. Zobler 
FTP site: ftp://daac.gsfc.nasa.gov/data/inter_disc/hydrology/soil/ 
File name: FAO_soil.textur.1nnegl.bin 
Converted Zobler’s seven texture classes to three for GeoSFM classes 
 GeoSFM class 1 (coarse) → sandy soils =1, + coarse =2 
 GeoSFM class 2 (medium) → loamy soils =7, + organic =4, + fine/medium =3 
 GeoSFM class 3 (fine) → clay soils =5 
Table 1.1 
GeoSFM Class Zobler Class Description 

1 Sandy soils 1 
 2 Coarse 

3 Fine/medium 
4 Organic 

2 
 
 7 Loamy soils 

3 5 Clay soils 
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KS – Hydraulic Conductivity 
 
Texture class source – NASA Technical Memo 87802 – 1986 
Titled: A world soil file for global climate modeling 
Authored: L. Zobler 
FTP site: ftp://daac.gsfc.nasa.gov/data/inter_disc/hydrology/soil/ 
File name: FAO_soil.textur.1nnegl.bin 
 
Ks value source – NASA Technical Memo 87802 – 1986 
Titled: A world soil file for global climate modeling 
Authored: L. Zobler 
FTP site: ftp://daac.gsfc.nasa.gov/data/inter_disc/hydrology/soil/ 
See Table 1.2 
 
Hydraulic conductivity values (Ks) are based on seven texture classes defined by the Zobler data 
set. 
 
Table 1.2 
Zobler  
Class 
Code 

FAOTexture Porosity Matric 
Potential 

Ks Bslope USDA 
Soil 
Texture 

Soil 
Hydraulic 
Class 
 

Numeric soil 
Hydraulic 
Class 

1 coarse 0.421 0.0363 5.076 4.26 loam sand a 88 
2 medium or 

coarse 
0.434 0.1413 1.882 4.74 sandy 

loam 
a 88 

3 medium 0.439 0.3548 1.217 5.25 loam b 89 
4 fine or 

medium 
0.404 0.1349 1.602 6.77 sandy clay 

or loam 
c 90 

5 fine 0.465 0.2630 0.882 8.17 clay or 
loam 

d 91 

6 ice 0.0 0.0 0.0 0.0 ice   
7 organic 0.439 0.3548 1.217 5.25 loam b 89 
 
 
WHC – Soil Water Holding Capacity 
 
Soil Class source – Digital Soil Map of the World (DSMW) CD-ROM 
FAOSOIL/DATA/SMAX1.ASC file contains the data elements record number, mapping unit, and 
the percentage of each mapping unit in one of the following seven classes. (water, A, B, C, D, E, & 
F) 
 
Soil water holding capacity source – Digital Soil Map of the World (DSMW) CD-ROM 
see Table 1.3 
 
 
The median soil moisture values in the total available water column in Table 1.3 were used for the 
calculations. 
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Table 1.3     Table soil water holding capacity by class 
Class Soil Moisture 

Range, Easily 
Available Water 

Soil Moisture 
Range, Total 
Available Water 

Median Soil 
Moisture, Easily 
Available Water 

Median Soil 
Moisture, Total 
Available Water 

Water 0 0 0 mm/m 0 mm/m 
A >120 mm/m >200 mm/m 150 mm/m 250 mm/m 
B 100-120 mm/m 150-200 mm/m 110 mm/m 175 mm/m 
C 60-100 mm/m 100-150 mm/m 80 mm/m 125 mm/m 
D 40-60 mm/m 60-100 mm/m 50 mm/m 80 mm/m 
E 20-40 mm/m 20-60 mm/m 30 mm/m 40 mm/m 
F <20 mm/m <20 mm/m 10 mm/m 10 mm/m 
 
 
Example calculation: 
Assume mapping unit example is –Water=10%, A=0%, B=40%, C=10%, D=0%, E=20%, and 
F=20%  
 
(Water/100*0) + (“A”/100*250) + (“B”/100*175) + (“C”/100*125) + (“D”/100*80) + 
(“E”/100*40) + (“F”/100*10) 
 
(10/100*0) + (0/100*250) + (40/100*175) + (10/100*125) + (0/100*80) + (20/100*40) + 
(20/100*10) 
 
0+0+70+12.5+0+8+2 
 
Total available water = 92.5mm of water 
 
Maxcover 
 
Land cover source – USGS Global Land Cover Characteristics (GLCC) database (Loveland et al., 
1999.) The GLCC data were derived from 1-km AVHRR data and are available in the Interrupted 
Goode Homolosine and Lambert Equal Area Azimuthal projections. The data are available for 
download over the Internet at http://edcdaac.usgs.gov/glcc/af_int.html.  See section 1.4.1 for 
instructions on creating landcover grid. 
 
Flow Accumulation grid source - 

• Stream assigned cell values are from the Flow Accumulation (flowacc) grid created during 
the terrain analysis processing.  If flow accumulation is greater than 1000 the cell is 
considered a stream cell in the Flow Accumulation grid.  (This value can be changed 
depending on the objectives and the scale.)  

• Hydro1K data set available from U.S. Geological Survey’s  Center for Earth Resources 
Observation Science. The data are available for download over the Internet at 
http://edcdaac.usgs.gov/gtopo30/hydro/.) 

 
All water bodies, and wetland cells from the GLCC, and all stream cells from the Flow 
Accumulation grid are combined to form a maxcover grid.   
 
Cell value → 1=water, 0=all other cells 
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RCN – Runoff Curve Number 
 
Land cover source – USGS Global Land Cover Characteristics (GLCC) database (Loveland et al., 
1999.) The GLCC data were derived from 1-km AVHRR data and are available in the Interrupted 
Goode Homolosine and Lambert Equal Area Azimuthal projections. The data are available for 
download over the Internet at http://edcdaac.usgs.gov/glcc/af_int.html.  See section 1.4.1 for 
instructions on creating landcover grid. 
 
Soil Hydraulic class source – 
Titled: Handbook of Hydrology – pg.5.25, 1993 
Authored: Editor –D.R. Maidment 
 
Soil Hydraulic classes are found in Table 1.2.  The Soil Conservation Service (SCS) has classified 
soils into four hydrologic soil groups according to their infiltration rate. 

• Group “A” consists of soils that have low runoff potential and high infiltration rates.  The 
USDA soil textures included in this group are sand, loamy sand, and sandy loam. The 
transmission rates of these soils are greater than 0.76 cm/h. 

• Group “B” consists of soils that have moderate infiltration rates. The USDA soil textures 
included in this group are silt loam, and loam.  The transmission rates of these soils are 
between 0.38 and 0.76 cm/h. 

• Group “C” consists of soils that have low infiltration rates.  The USDA soil texture included 
in this group is sandy clay loam.  The transmission rates of these soils are between 0.13 and 
0.38 cm/h. 

• Group “D” consists of soils that have very low infiltration rates.  The USDA soil textures 
included in this group are clay loam, silty clay loam, sandy clay, silty clay, and clay.  The 
transmission rates of these soils are between 0.0 and 0.13 cm/h. 

From these four soil class groups, numeric values were given to ease the grid creation process. The 
Numeric Soil Hydraulic classes, found in the last column, will be used when creating the RCN grid. 
 
SCS Runoff Curve Number source –  
Titled: Applied Hydrology, pg. 150, 1988  
Authored: V.T. Chow, D.R. Maidment, and L.W. Mays 
SCS runoff curve number from Table 1.4 below. 
 
 Hyd_a_mean = soil hydraulic class A 
 Hyd_b-mean = soil hydraulic class B 
 Hyd_c_mean = soil hydraulic class C 
 Hyd_d_mean = soil hydraulic class D 
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Table 1.4 
nlucode Lu_code Description Hyd_a_mean Hyd_b_mean Hyd_c_mean Hyd_d_mean 

0 0 Unclassified 54.0 70.0 80.0 85.0 
1 100 Urban and Built-Up Land 81.0 88.0 91.0 93.0 
2 211 Dryland Cropland and Pasture 68.0 79.0 86.0 89.0 
3 212 Irrigated Cropland and Pasture 62.0 71.0 78.0 81.0 
4 213 Mixed dryland/Irrigated crop land and pasture 65.0 75.0 82.0 85.0 
5 280 Cropland/Grassland Mosaic 65.0 75.0 82.0 85.0 
6 290 Cropland/Woodland Mosaic 45.0 66.0 77.0 83.0 
7 311 Grassland 54.0 70.0 80.0 85.0 
8 321 Shrubland 45.0 66.0 77.0 83.0 
9 330 Mixed shrumland/grassland 49.5 68.0 78.5 84.0 

10 332 Savanna 57.0 73.0 82.0 86.0 
11 411 Deciduous Broadleaf Forest 45.0 66.0 77.0 83.0 
12 412 Deciduous needleleaf Forest 45.0 66.0 77.0 83.0 
13 421 Evergreen Broadleaf Forest 25.0 55.0 70.0 77.0 
14 422 Evergreen needleleaf Forest 25.0 55.0 70.0 77.0 
15 430 Mixed forest 35.0 60.5 73.5 80.0 
16 500 Water Bodies 98.0 98.0 98.0 98.0 
17 620 Herbaceous Wetland 30.0 58.0 71.0 78.0 
18 610 Wooded Wetland 25.0 55.0 70.0 77.0 
19 770 Barren or Sparsely Vegetated 68.0 79.0 86.0 89.0 
20 820 Herbaceous Tundra 98.0 98.0 98.0 98.0 
21 810 Wooded Tundra 98.0 98.0 98.0 98.0 
22 850 Mixed tundra 98.0 98.0 98.0 98.0 
23 830 Bare ground tundra 98.0 98.0 98.0 98.0 
24 900 Snow or Ice 98.0 98.0 98.0 98.0 

 
 
Creating Soil Characteristic Grids 
 
Create a new folder for DSMW data to be stored in the GeoSFM folder. Download DSMW data 
from the CD into c:\geoSFM\dsmw.  The downloaded files are: 

• 1STREAD 
• ERDAS 
• FAOSOIL 
• IDRISI 
• RASTEXPN 
• VECTOR 
• READ1ST.txt 

 
Now, you can begin to import the data into our ArcView project for use in exercise one as outlined 
in the GeoSFM Training Manual. 
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First, import the vector files by clicking on Start/Programs/ESRI/ArcView 3.2a/Import71 as seen 
below.   

 
 
The vector files are found in the Vector folder where they are listed by ten different regions, for 
exercise one we will chose data for Africa.  There are ten files for Africa AFSNTLL.e00 -.e09; by 
selecting .e00 all files are added.   
Browse to populate Export Filename:  
c:\geoSFM\dsmw\Vector\AFSCNTLL.E00.   
Browse to populate the Output Data Source.   
Click OK. 

 
 
Import71 Utility dialog box displays stating Import Complete, click OK. 

 

Add the AFSCNTLL file to the View using Add Theme button  from the View menu.  
Change the Data Source Types to Feature Data Source.  Click on the afscntll file from the 
c:\GeoSFM\dsmw directory and click OK to add to the View.  

 



 

 29

Next, convert Afscntll to a shapefile. Select the theme Afscntll so that it appears in a raised box.  
From the Theme menu select Convert to Shapefile… 

 
 
The Convert Afscntll dialog box appears.  Navigate to the c:\GeoSFM\dwms directory and name 
your new shapefile in File Name.  Then click OK. 

 
 
The new shapefile is added below.   

 
 
Next, you need to project the shapefile to Lambert Equal-Area Azumuthal.   
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Start by activating the Projector! Extension, from the File menu select Extensions.  Scroll down to 
Projector! and click in the box to the left, to select it, click OK. 

 
 
The tool bar is updated to add the change projection button. 
 

 
Click on the change projection button to start the projection process. The first dialog box is 
displayed, select meters from the drop down list for the output units.  Click OK. 

 
 
Next, the Projection Properties box is displayed. Select the Custom radio button. In the 
Projection drop down list select Lambert Equal-Area Azimuthal.  Change the Central Meridian 
to 20 and the Reference Latitude to 5 for the continent of Africa. 
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Click Yes when prompted, “Recalculate area, perimeter and length fields {if present} using 
meters?” 

 
 
Select Yes, when asked to, “Add projected shapefile as theme to a view?” 

 
 
 
Next, select the view where you want the theme added.  Select View1 and click OK. 

 
 
Navigate to your directory, and under File Name: name your new projected shapefile.  Click OK. 

 
 
Now, you can delete the original africasoil.shp, from Edit menu select Delete Theme option. 
(Make sure your theme is in a raised box.) 
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Before you begin creating the soil depth grid add the elevations theme to your view.  You will use 
this theme to define the output grid extent and the cell size.   

Add the elevations file to the View using Add Theme button  from the View menu.  Change 
the Data Source Types to Grid Data Source.  Click on the elevations file from the 
c:\GeoSFM\demdata directory and click OK to add to the View.  

 
 
Now, you can begin to create six different soil characteristic grids, these grids will be needed for 
generating the Basin Characteristics File.   
 
Soil Depth 
 
Soil depth will be the first grid created; it is a hydrological active soil layer depth grid.  The source 
for this data will be a data set found in NASA Technical Memorandum 4286.  The document is titled 
A global Data Set of Soil Particle Size Properties and was written by Robert Webb, Cynthia E. 
Roesnzweig, and Elissa R. Levine. On page 21, Table 5, is a data set of soil thickness for 106 soil 
types for nine continents.  You will need to capture the Soil Code and the data in the Africa column 
for completing this exercise.  Create a text document with two columns of data, example below. 
(Notice soil code first character is upper case and the second character is lower case.) 
 

 
 
 
 

Populate: 
File name: 
  “afsoildepth.txt” 
Save as type: 
   CSV (Comma      
delimited) (*.csv) 
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Table displayed in Notepad. 

 
 
The next text document you will create will capture the FAOSOIL code and the Soil Code values.  
The source for this data is found on the DSMW CD in the FAOSOIL\DATA folder. Africa is 
divided into two files; you will use both AFRIC1.DAT and AFRIC2.DAT. 
 
You will need to capture the data in both the Faosoil column (4th column) and the Soil Code 
column (8th column.)  Create a text document with the two columns of data, example below.  
Include data from both files (AFRIC1 & AFRIC2.) 
 

 
 
Table displayed in Notepad. 

 

Populate: 
File name: 
“soilcode.txt” 
 
Save as type: 
CSV (Comma 
delimited) (*.csv) 
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Now, you can add the tables to your view by selecting Tables and clicking the Add button in the 
Project window. First, select the soilcode.txt as seen below.  Click OK. 

 
 
 
Open the attribute table of Projafsoil.shp by selecting the Projafsoil theme and clicking on the 
Table icon on the tool bar.  
 

 
 
Position the tables as seen below. Click/highlight the common column headers in both tables –
Faosoil in Attributes of Projafsoil and in Faosoil in soilcode.txt.  Make the destination table 
active (adding fields to Attributes of Projafsoil.shp).   

 
 
Click on the Join icon, the new column is added to the Attributes of Projafsoil table. 
 

 
 
Again, select Tables and click the Add button in the Project window to add the second table to the 
view.  This time select afsoildepth.txt.  Click OK.  
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Position the tables side by side. Click/highlight the common column headers in both tables –Soil 
code in Attributes of Projafsoil and in Soilcode in afsoildepth.txt.  Make the destination table 
active (adding fields to Attributes of Projafsoil.shp).   
 
Click on the Join icon, the new column is added to the Attributes of Projafsoil table. 
 
Now, you will add a new field to the Attributes of Projafsoil.shp.  From the Table menu select 
Start Editing. 

 
  
Then from the Edit menu select Add Field. 

 
 
The Field Definition dialog box opens.   
Populate:  
Name: with the name of your new field 
Type: number 
Width: defaults to 16 –changed to 3  
Decimal Places: 0  

 
 
Select the calculator icon on the tool bar. 
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The Field Calculator opens enter the following calculation:  
[soildepth] = [Africa] 
Click OK. 

 
 
The new soildepth field will be populated with the values from the Africa field. 
In the Table menu select Save Edits, this will save the changes to the attribute table.  Then, in the 
Tables menu select Stop editing. 
 
Now you will create a new grid with the data from the soildepth field. From the Theme menu select 
Covert to Grid. 

 
 
The Convert Projafsoil.shp dialog box opens.  Select c:\geosfm\dsmw directory and name your 
grid in Grid Name. Click OK. 
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Conversion Extent dialog box opens. In Output Grid Extent select Same as Elevations from the 
drop down list.  Output grid cell size: Same as Elevations.  The other values will default. Click 
OK. 

 
 
Next, the Conversion Field dialog box opens.  In Pick field for cell values: select soildepth.  
Click OK. 

 
When asked to, “Add grid as theme to the view?” click Yes. 

 
 
New Africa soil depth grid is displayed. 
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Texture 
 
The second soil grid you will create is texture.  The GeoSFM uses three different texture classes 
when generating the basin characteristics file. These classes are coarse, medium, and fine. 
 
The texture data set is from Zobler, 1986 and is found at the following FTP site, 
ftp://daac.gsfc.nasa.gov/data/inter_disc/hydrology/soil/.  The file we will be using is 
FAO_soil.textur.1nnegl.bin.   
 
The following procedure is needed before importing these binary files into ArcView. 
 
Re-name the FAO_soil.textur.1nneg1bin file to filename texture.bil. 
 
Next, you will create a header file.  
Data fields that are needed for the creation of the header file: 

• ncols – the number of columns in the data set 
• nrows – the number of  rows in the data set 
• xllcorner –the x-coordinate of the center or lower-left corner of the lower-left cell 
• yllcorner –the y-coordinate of the center or lower-left corner of the lower-left cell 
• cell size –cell size of the data set 
• nodata_value –value in the file assigned to cells whose value is unknown.  This keyword 

and value is optional.  The nodata_value defaults to -9999. 
• byteorder – the byte order of the binary cell values.  You can choose between two keywords, 

msbfirst or lsbfirst. Msbfirst is used for cell values written with the most significant bit first.  
Lsbfirst is used for cell values written with the least significant bit first. 

 
The parameters needed to populate the new header file can be found in the Readme.fao_soil 
documentation.  
 
Now that you have the data you need, you can prepare an ASCII file.  To do this, open up WordPad 
in Start/Programs/Accessories/WordPad.  
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An example of the WordPad document can be seen below.   

 

Save the document from the File menu select Save As… 
File Name –texture.hdr 
Save as Type –Text Document  
Directory –c:\GeoSFM\Zobler 
 
Next, you will import the texture.bil; from the File menu select Import Data Source.  

 
 
The Import Data Source dialog box is displayed; from the drop down list select Binary Raster.  
Click OK. 
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Navigate to your directory, change the List Files of Type: to All Files (*.*).  Now you can select 
the texture.bil to populate the File Name.  Click OK. 

 
 
The Output Grid dialog box opens, navigate to your directory, name your new grid under Grid 
Name.  You are now converting the .bil to a grid. Click OK.   

 
 
Select Yes when prompted to, “Add grid as theme to the View?” 

 
 
New Texturegeo grid is displayed. 
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Zoom into the continent of Africa by clicking on the zoom icon and putting a box around Africa. To 
accomplish this, click on one corner of the area you want to capture, hold the mouse button and 
drag to the opposite corner, boxing in Africa.    See display below.   

 
 
Now, you will set the analysis extent to the display, so you can clip the African continent (what is 
captured in our display area) from the global data set. 
 
From the Analysis menu select Properties.  Select Same As Display from the drop down list to 
define the Analysis Extent. Use the default values for all other fields.  Click OK. 
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The Analysis extent is now defined; using the Map Calculator you can clip the extent area from 
the global data area.  To accomplish this, click on the Analysis menu and select Map Calculator, 
from here select the Texturegeo layer.  Click Evaluate. 

 
 
The Map Calculation 1 theme is displayed below.  You now have a grid of Africa. 

 
 
Next, you will project the grid in the Lambert Equal-Area Azimuthal projection to match the other 
data sets used in the GeoSFM.  You will use the GeoSFM Utilities tool to project the grid; from the 
GeoSFM Utilities menu select Raindata: ProjectGrid, Geo to Lambert Azimuthal.  Normally, this 
function is used for projecting rain and PET data, but you can project any grid except for large 
global data sets. 
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In the first window Specify your working directory.  Click OK. 

 
 
Next, Select the continent for analysis, from the drop down list select Africa.  Click OK. 

 
 
Click on Yes, when prompted to project grid to Lambert Equal-Area Azimuthal. 

 
 
Use default values for Analysis Properties.  Click OK. 

 
 
The last dialog box informs you that the data set will need to be saved.  Click OK. 
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Before you save the data set, you will need to change the cell size to match the cell size of the other 
data you are using. 
 
First, you need to add the elevations grid. Click on the Add theme icon. Navigate to the demdata 
folder.  Change the data source type to Grid Data Source, select elevations.  Click OK. 

 
 
After the elevations theme is added, click on the Analysis menu and select Properties.   

 
Click OK. 
 
Now, you have the cell size defined you need to re-sample the Map Calculation 1.  
 
 
 
 
 
 
 
 
 

Populate: 
Analysis Extent – 

Same As Map 
Calculation 1 

 
Analysis Cell Size – 

Same As Elevations 
 
Analysis Mask – 

Elevations   
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From the Analysis menu select Map Calculator.  Double click on the Map Calculation 1 under 
layers to populate evaluate window.  Click Evaluate button. 

 
 
Map Calculation 2 is now projected with a cell size of a 1000.   

 
 
To save the data set, from the Theme menu select Save Data Set.  
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Navigate to your working directory, and name your new grid.  Click OK. 

 

Add the projtexture file to the View using Add Theme button  from the View menu.  
Change the Data Source Types to Grid Data Source.  Navigate to your working directory and 
select projtexture.  Click OK to add to the View. 

 
 
To delete the Map Calculation 2, select the theme in your table of contents. Then from the Edit 
menu select Delete Themes. 

 
New projected texture grid displayed below. 
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Next, you need to convert the seven different texture classes to GeoSFM’s three classes. 
 
To begin this process you need to work with integers.  From the Analysis menu select the Map 
Calculator.  Double click on projtexture to populate the evaluation window, type in the following 
expression exactly as shown:   
([Projtexture]) .Int 
Click Evaluate. 

 
 
Now, you are working with values 0-7. –Map Calculation 1. 

 
 
Next, you will define GeoSFM class 1, which will be classes 1 and 2 from the Map Calculation1 
theme.  
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From the Analysis menus select Map Calculator, type in the following expression exactly as 
shown:   
( [Map Calculation 1] = 1) or ([Map Calculation 1] = 2).Con(1.AsGrid, 0.AsGrid)   
Click the Evaluate button. 

 
 
 
Next, you will define GeoSFM class 2, which are classes 3, 4 and 7 from the Map Calculation1 
theme.  From the Analysis menus select Map Calculator, type in the following expression exactly 
as shown:   
([Map Calculation 1] = 3) or ([Map Calculation 1] = 4) or ([Map Calculation 1] = 
7).Con(2.AsGrid, 0.AsGrid) 
Click the Evaluate button. 
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To change the grid value from l to 2 for our GeoSFM class 2 you need to perform the following 
calculation. From the Analysis menus select Map Calculator, type in the following expression 
exactly as shown:  
 ( [Map Calculation 3] * 2) 
Click the Evaluate button. 

 
 
Next, you will define GeoSFM class 3, which is class 5 from the Map Calculation 1 theme. From 
the Analysis menus select Map Calculator, type in the following expression exactly as shown:  
( [Map Calculation 1] = 5).Con(3.AsGrid, 0.AsGrid) 
Click the Evaluate button. 

  
 
Next, you need to combine the results from Map Calculations 2 and 4 to form a grid that displays 2 
classes. Each cell can only carry one value, to prevent an error in cell value by having cell values 
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adding together, you will combine the data as follows: from the Analysis menus select Map 
Calculator, type in the following expression exactly as shown:  
( [Map Calculation 2] = 1).Con([Map Calculation 2],[Map Calculation 4]) 
Click the Evaluate button. 

 
 
For the final calculation, you will include the third class to create a grid with all three classes. From 
the Analysis menus select Map Calculator, type in the following expression exactly as shown:  
( [Map Calculation 6] = 0).Con([Map Calculation 5],[Map Calculation 6]) 
Click the Evaluate button. 
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Map Calculation 7 is the final grid with the corrected texture classes.  To save this data set, click on 
Map Calculation 7 to activate the theme in the table of contents, from the Theme menu select Save 
Data Set. 

 
 
Navigate to your working directory. In Grid Name type texture as your new grid name.  Click OK. 

 
 
Final Texture grid is displayed below. 
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Hydraulic Conductivity 
 
The third soil characteristic grid you will create is Ks. This is the hydraulic conductivity and is 
based on the seven Zobler texture classes defined in the instructions for creating the texture grid. 
 
First, you will add the projtexture grid used in defining the texture classes. Add the projtexture 

file to the View using Add Theme button  from the View menu.  Change the Data Source 
Types to Grid Data Source.  Navigate to your working directory and select projtexture.  Click 
OK to add to the View. 
 

 
 
To begin this process you need to work with integers.  From the Analysis menu select the Map 
Calculator.   

 
 
This opens the Map Calculator window.  
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Double click on projtexture to populate the evaluation window, type in the following expression 
exactly as shown:   
([Projtexture]) .Int 
Click Evaluate. 

 
 
This produces the Map Calculation 1 grid with values 0-7. 

 
 
Next, you need to use the Ks values found in Table 1.2 (in the Soil Characteristic Data Sources 
above.)  Notice the relationship of the Ks values to the original seven texture classes.  This is why 
you are using the projtexture grid generated in the texture processing above. 
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From the Analysis menu select the Map Calculator.  Type in the following expression exactly as 
shown:   
 
( [Map Calculation 1] = 1).Con(5.076.AsGrid, ([Map Calculation 1] = 2).Con(1.882.AsGrid, 
([Map Calculation 1]=3).Con(1.217.AsGrid, ([Map Calculation 1]=4).Con(1.602.AsGrid, 
([Map Calculation 1]=5).Con(0.882.AsGrid, ([Map Calculation 1]=7).Con(1.217.AsGrid, [Map 
Calculation 1])))))) 

 
 
Once the new grid is created you can check your data values by selecting both, your new grid (Ks or 
Map Calculation 2) and the projtexture or Map Calculation 1 grid.  To select more than one Theme 
at a time hold down the shift key while making your selections.  Click on the Identify icon and then 
click on a cell in your grid.   
 

 
 
The Identify Results window will open showing the values.  If the Ks grid is highlighted in the 
table the Ks value will display, 1.217 as shown below.  If the projtexture or Map Calculation 1 is 
highlighted than the value is 3.  This corresponds with our original table, where the texture value 3 
has a Ks value of 1.217. 
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The Map Calculation 2 grid is the final Ks grid, so we will save this data set. From the Theme 
menu select Save Data Set. 

 

Navigate to your working directory, and name your new grid Ks.  Click OK. 

 

Add the Ks grid to the View using Add Theme button  from the View menu.  Change the 
Data Source Types to Grid Data Source.  Navigate to your working directory and select Ks.  
Click OK to add to the View.  The other Themes can be deleted by selecting the themes and then 
from the Edit menu select Delete Themes.  Below is the final Ks grid. 
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WHC – Soil Water Holding Capacity  
 
The next soil characteristic grid you will create is the soil water holding capacity grid. 
The source for this data will be the SMAXl.ASC file found on the FAO Digital Soil Map of the 
World CD in the FAOSOIL\DATA\folder.  You will need to join the data in this file to the 
projafrica.shp file. 
 
Start by opening the SMAX1.ASC file in WordPad.  Add a line at the top for header information. 
The file contains a record number, the mapping unit name, and the soil classes of water, A, B, C, D, 
E, and F. 
 
Add: RecNum, MapUnit, Water, A, B, C, D, E, and F as shown below. 

 
 
From the File menu select Save As… navigate to your directory. 

 
 
 
Next, add the projafsoil.shp to the View. Add the shapefile to the View using Add Theme button 

 from the View menu.  Change the Data Source Types to Feature Data Source.  Navigate to 
your working directory and select projafsoil.shp.  Click OK to add to the View. 

 
 

Populate: 
File name: 
     WHC.txt 
Save as type: 
      Text Document 
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In View click on the projafsoil.shp so it appears in a raised box, click on the open theme table 
icon. 

 
 
Next, you need to add the new whc.txt to the View.  From the project window select Tables and 
than click the Add button. Navigate to your working directory and select whc.txt, List Files of 
Type will need to be Delimited Text (*.txt.) Click OK. 

 
 
Arrange both tables as seen below.  Click/highlight the common column headers in both tables –
Faosoil in Attibutes of projafsoil.shp and Mapunit in whc.txt file.  Make the destination table 
active (adding fields to Attributes of Projafsoil.shp.) 

 
 
Click on the join icon, the new columns are added to the Attributes of Projafsoil.shp table. 
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Now, you will add a new field to the attribute table.  From the Table menu select Start Editing. 

 
 
Then from the Edit menu select Add Field. 

 
 
The Field Definition box opens. 
Populate: 
Name: whc 
Type: Number 
Width: 5 
Decimal Places: 3 

 
Click OK. 
 
Select the calculator icon on the tool bar. 

 
 
 
 
 
 
 
 
 



 

 59

This will display the Field Calculator, enter the following expression: 
(([Water] / 100) * 0) + (([A] / 100) * 250) + (([B] / 100) * 175) + (([C] / 100) * 125) + (([D] / 100) 
* 80) + (([E] / 100) * 40) + (([F] / 100) * 10) 
Click OK. 

 
 
The water, A, B, C, D, E, and F values correspond with the soil class values listed in the attribute 
table.  The values that are multiplied are the median soil moisture, total available water found in 
Table 1.2. 
 
After a few moments for processing the whc values are populated in the new column. 

 
 
Next, you will save the edits, from the Table menu select Save Edits. 
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The Save Edits dialog box is displayed -click the Yes button. 

 
 
From the Table menu select Stop Editing.  This will end the editing secession. 

 
 
You need to set the Analysis extent before you create the new whc grid. 

Add the elevations grid to the View. Add the grid to the View using Add Theme button  from 
the View menu.  Change the Data Source Types to Grid Data Source.  Navigate to your working 
directory and select elevations.  Click OK to add to the View. 

 
Now, from the Analysis menu select Properties.   The properties dialog box is displayed. 

 

Populate: 
Analysis Extent: 
 Same As Projafsoil.shp 
Analysis Cell Size: 
 Same As Elevations 
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Click OK. 
From the Theme menu select Convert to Grid. 

 
 
Navigate to your working directory, type in Grid Name –whc.  Click OK. 

 
 
When prompted for Conversion Field, select whc from the drop down list.  Click OK. 

 
 
Click Yes, when asked, “Add grid as theme to the View?” 
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New whc grid is shown below. 

 
 
 
Maxcover 
 
The next soil characteristic grid that you will create is maxcover. It is the area covered by a wetland 
or water body in the GLCC data or designated as a stream in the flow accumulation grid. 

Add the grid to the View using Add Theme button  from the View menu.  Change the Data 
Source Types to Grid Data Source.  Navigate to the land cover directory and select usgslandcov.  
Click OK to add to the View. 

 
Then add the flow accumulation grid to the View. Add the grid to the View using Add Theme 

button  from the View menu.  Change the Data Source Types to Grid Data Source.  
Navigate to the workspace directory and select flowacc.  Click OK to add to the View. 
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Next, you will define the analysis extent. 

 
Click OK. 
 
Next, you will select all water bodies and wetland areas from the landcover grid.  
Values: 16 – Water Bodies 
  17 – Herbaceous Wetland 
  18 – Wooded Wetland 
From the Analysis menu select the Map Calculator.  Type in the following expression exactly as 
shown:   
( [Usgslandcov] = 16).Con(1.AsGrid, ([Usgslandcov] = 17).Con(1.AsGrid, ([Usgslandcov] = 
18).Con(1.AsGrid, 0.AsGrid)))    Click Evaluate. 

 

Populate: 
Analysis Extent- 
       Same As Flowacc 
 
Analysis Cell Size- 
       Same As Flowacc 
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This creates Map Calculation 1 with all water body and wetland cells assigned a value of 1, all other 
cells are assigned a value of 0. 

 
 
Next, you will select all cells with a value equal to or greater than 1000 in the flow accumulation 
grid.  These cells are defined as streams in the flow accumulation grid.  From the Analysis menu 
select the Map Calculator.  Type in the following expression exactly as shown:   
( [Flowacc] >= 1000).Con(1.AsGrid, 0.AsGrid) 
Click Evaluate. 

 
 
This creates Map Calculation 2 with all stream cells assigned a value of 1, all other cells assigned a 
value of 0.   



 

 65

 
 
With the next calculation you will combine the water body, wetland, and stream cells in one grid. 
From the Analysis menu select the Map Calculator.  Type in the following expression exactly as 
shown:    
( [Map Calculation 1] = 0).Con([Map Calculation 2], [Map Calculation 1]) 
Click Evaluate. 

 
 
You have created a grid with all water bodies, wetlands, and streams assigned a cell value of one.  
All other cell values are assigned a value of 0. 
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Save the new grid, from the Theme menu select Save Data Set. 

 
 
Navigate to your directory; name your grid maxcover in Grid Name.  Click OK. 

 
Delete the themes you no longer need from the table of contents.  From the Edit menu select Delete 
Themes. 
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Add the new maxcover grid to the View. Add the grid to the View using Add Theme button  
from the View menu.  Change the Data Source Types to Grid Data Source.  Navigate to your 
dsmw directory and select maxcover.  Click OK to add to the View. 
 

 
 
Below is the final maxcover grid. 

 
 
RCN 
The last soil characteristic grid you will create is the Soil Conservation Service (SCS) runoff curve 
number (RCN) grid.  The runoff curve numbers are estimated from land cover classes and hydraulic 
soil groups. 

First, you will add the land cover grid.  Add the grid to the View using Add Theme button  
from the View menu.  Change the Data Source Types to Grid Data Source.  Navigate to your land 
cover directory and select usgslandcov.  Click OK to add to the View. 
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Then add the protexture grid. Add the grid to the View using Add Theme button  from the 
View menu.  Change the Data Source Types to Grid Data Source.  Navigate to your directory and 
select projtexture.  Click OK to add to the View. 

 
After you have added the landcover and projected texture grids to the view, you will set the 
Analysis Extent.  From the Analysis menu select Properties.  The Analysis Properties dialog box 
will be displayed. 

 
 
 
 

Populate: 
Analysis Extent- 
      Same As Usgslandcov 
 
Analysis Cell Size- 
      Same As Usgslandcov 
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To begin this process you need to work with integers.  From the Analysis menu select the Map 
Calculator.   

 
 
This opens the Map Calculator window. Double click on projtexture to populate the evaluation 
window, type in the following expression exactly as shown:  
([Projtexture]) .Int 
Click Evaluate. 

 
 
This produces the Map Calculation 1 grid with values 0-7. 
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Next, you will create a soil hydraulic class grid.  First, you will need to create a text file from Table 
1.2. (see Soil Characteristic Data Sources) in Excel. 
 
Save as: 

 
 
 
Now you can join the texture.txt to the attribute table of Map Calculation 1.   
 
In View click on the Map Calculation 1 theme so it appears in a raised box, click on the open 
theme table icon. 

 
 
Next, you need to add the new texture.txt to the View.  From the project window select Tables and 
than click the Add button. Navigate to your working directory and select texture.txt, List Files of 
Type is set to Delimited Text (*.txt.) Click OK. 
 

 
 
Arrange tables side by side.  Click/highlight the common column headers in both tables –Value in 
Attributes of Map Calculation 1 and Index in the texture.txt file.  Make the destination table 
active (adding fields to Attributes of Map Calculation 1.) 
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Click on the join icon, the new columns are added to the Attributes of Map Calculation 1 table. 
 

 
 
Now you can create a grid of the Numeric soil hydraulic classes.   From the Analysis menu select 
the Map Calculator.  Type in the following expression exactly as shown: 
( [Map Calculation 1 . Numeric soil hydraulic class]) 
Click Evaluate. 

 
 
Below the created grid is displayed - with values of 0, 88, 89, 90, and 91. 
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Save this data set, from the Theme menu select Save Data Set. Navigate to your directory and 
name your new grid –soilhyd.  Click OK. 

 

Now, you can delete all themes, except for the usgslandcover grid; from the Edit menu select 
Delete Themes. Make sure the themes you want deleted are selected in a raised box.  Now add your 
new soilhyd grid to your view.  You will use this grid later in the process. 
 
Create four grids for each Soil Hydraulic class (A, B, C & D) each with the RCN values for the 
landcover classes.  The Hyd_a_mean field in the usgslandcov attributes table, indicates the RCN 
values for soil hydraulic class “A”, Hyd_b_mean for soil hydraulic class “B”, Hyd_c_mean for 
soil hydraulic class “C”, and Hyd_d_mean for soil hydraulic class “D”.  If your attribute table does 
not contain these Hyd_a-d_mean values you will need to add them to the table. 
 
If you need to add values to the land cover attribute table create Table 1.4 (see Soil Characteristic 
Data Sources) in Excel. 
 
Save as: 

 
 
 
Next, you need to add the new rcn.txt to the View.  From the project window select Tables and 
than click the Add button. Navigate to your working directory and select rcn.txt, List Files of Type 
is set to Delimited Text (*.txt.) Click OK. 
 
Arrange tables side by side.  Click/highlight the common column headers in both tables –Value in 
Attibutes of Usgslandcov and nlucode in the rcn.txt file.  Make the destination table active 
(adding fields to Attributes of Usgslandcov.) 
 
Click on the join icon, the new columns are added to the Attributes of Usgslandcov table. 
 
Next, you will create the four grids; the first grid will capture all the Hyd_a_mean values. 



 

 73

From the Analysis menu select the Map Calculator.  Type in the following expression exactly as 
shown: 
([Usgslandcov.Hyd_a_mean])  You can double click on the field under Layers to populate the 
evaluation area.  Click on Evaluate. 

 
 
Save your new data set, from the Theme menu select Save Data Set. 

  
 
Navigate to your working directory and type in Grid Name – a_rcn.  Click OK. 
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Repeat this process for the remaining three grids.  The second grid will capture the Hyd_b_mean 
values and saved as b_rcn.  The third grid will capture the Hyd_c_mean values and saved as 
c_rcn.  The last grid will capture the Hyde_d_mean values and saved as d_rcn. 
 
Delete all the Map Calculation 1-4 grids, and add the newly created a_rcn, b_rcn, c_rcn and d_rcn 
grids.  You can select more than one grid by holding down the shift key while selecting. 

Add the grids to the View using Add Theme button  from the View menu.  Change the Data 
Source Types to Grid Data Source.  Navigate to your directory and select the four grids.  Click 
OK to add to the View. 

 
 
The next step is to combine the grids into one final rcn grid.  From the Analysis menu select the 
Map Calculator.  Type in the following expression exactly as shown: 
([Soilhyd]=88).con([A_rcn],([Soilhyd]=89).con([B_rcn],([Soilhyd]=90).con([C_rcn],([Soilhyd]= 
91).con([D_rcn], 0.AsGrid)))) 
Click on Evaluate. 
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Save your new data set, from the Theme menu select Save Data Set. 

  
 
Navigate to your working directory and type in Grid Name – rcn.  Click OK. 

 

 
Now, you can delete all the themes in the view and add your new rcn grid –seen below. 

 
 
All of the soil characteristic grids have been created.  Now the soil grids can be added to the View 
when prompted during the Creating Basin Characteristics process in section 1.5 in the GeoSFM 
Training Manual. 
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1.3.2 Basin Characteristics Output Files 

 
Basin and River Characteristics Output 
Output Files Description 
basin.txt  
see .txt file detail below 

File containing each sub-basin characteristics.  This file is 
rewritten during the calibration process for each model run. 

basin_original.txt Copy of basin.txt.  Retains original basin characteristic data. 
order.txt 
see .txt file detail below 

Computational order – used in subsequent program 
operations 

river.txt 
see .txt file detail below 

File containing river characteristics.  This file is rewritten 
during the calibration process for each model run. 

river_original.txt Copy of river.txt.  Retains original river characteristic data. 
describe.txt  see .txt file 
detail below 

File descriptions for twelve different files generated in 
modeling process  

 
basin.txt 
Parameters 

Description Units Range of 
Values 

BasinID Sub-basin identification number  1-366 
SoilWHC Soil water holding capacity calculated 

from the DSMW soil class and the total 
available water median soil moisture 
value. 

mm 76-175 

SoilDepth Hydrological active soil laver depth 
created from DSMW soil code value 
and Webb’s soil depth values. 

cm 100-360 

Texture Texure value created from Zobler’s 
seven classes and converted to three 
classes –coarse, medium, and fine. 

 1-5 

Ks Saturated soil hydraulic conductivity 
value created based on Zobler’s Ks and 
texture values. 

cm/hr 0.882 – 5.076 

Area Drainage area of the sub-basin km^2 4-10166 
Interflowlag Residence time for the interflow 

reservoir 
days 30 

Hslope Average sub-basin slope  0.001-1.6815 
Baseflowlag Residence time for the baseflow 

reservoir 
days 365 

RCNumber SCS runoff curve number uses 
hydraulic soil classes together with 
GLCC classes to derive a RCN value. 

 56.3-84.3 

MaxCover Maximum impervious cover value 
based on wetland area and water bodies 
found in the GLCC data set a long with 
the stream cells defined in the flow 
accumulation data. 

 0-0.002 
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BasinLoss Fraction of the soil water infiltrating to  
ground water 

 0.4-0.8 

Pancoeff Pan coefficient for correcting PET 
readings 

 0.85 

Topsoil Fraction of soil layer classified as 
hydrologically active top soil layer 

 0.1 

Aridity Aridity index range (1=arid, 2=wet)  1-2 
 
 
order.txt 
Parameters 

Description Range of 
Values 

BasinID  Most downstream sub-basin Number 1-366 
 2nd most downstream sub-basin Number  
 3rd most downstream sub-basin Number  
 ↓  
 Most upstream sub-basin Number  
 
river.txt 
Parameters 

Description Units  Range of 
Values 

RiverID Identification number of the river reach  1-366 
Area Local drainage area of the river reach km^2 4-10166 
UpArea Total area upstream of the river reach km^2 1003-415620 
RivSlope Average slope of the river reach/basin 

mainstream channel mean slope 
 0.001-1.1557 

RivLength  Length of the river reach m 1000-
313816.2 

DownID Identification number of the downstream 
river reach 

 -9999-365 

RivManning Value of Mannings n for the river reach  0.035 
RiverLoss Fraction of river water lost to infiltration  1 
RiverPloss Fraction of the river water lost to 

evaporation 
 1 

HasDam Indicates whether the river reach 
contains a dam (0=no, 1=yes) 

 0-1 

HasRating Indicates whether the reach has a rating 
curve (0=no, 1=yes) 

 0-1 

HasFlowData Indicates whether the river reach has 
observed flow data (0=no, 1=yes) 

 0-1 

Celerity Velocity of the flood wave through the 
river reach 

m/s 0.3-1.6 

Diffusion Flow attenuation (or dispersion) 
coefficient of the reach 

m^2/s 45-42695.2 

RivWidth Average channel width m 67-545.9 
FlowRef Reference flow for the section m^3/s 1.3701-

283.279 
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RunType Indicates if simulation should proceed 
from a existing or a new run (0=new, 
1=existing) 

 0-1 

 
 
describe.txt Description 
Basin Characteristics List and description of the twelve different characteristics 

generated in the basin.txt 
River Characteristics List and description of the seventeen different characteristics 

generated in the river.txt 
Response Characteristics Explanation of the time step runoff data generated in the 

response.txt 
Computation Order Explanation of the sub-basin downstream/upstream flow in the 

order.txt 
Rainfall Characteristics Explanation of the time step rainfall data generated in the rain.txt
Evapotranspiration 
Characteristics 

Explanation of the time step PET data generated in the evap.txt 

Balance Parameters List and description of the nine different characteristics 
generated in the balparam.txt 

Balance File Listing List and description of the seventeen different input/output files 
in the balfiles.txt 

Route Parameters List and description of the nine different characteristics 
generated in the routparam.txt 

Route File Listing List and description of the thirteen different input/output files in 
the routfiles.txt 

Total Runoff from each 
Sub-basin 

Explanation of the time step total runoff data generated in the 
basinrunoffyield.txt 

Total Stream flow from 
each  Sub-basin 

Explanation of the time step total discharge generated in the 
streamflow.txt 

 
 
 

1.4 Generate Basin Response File 

 
GeoSFM is a semi-distributed hydrologic model. This implies that a single value of precipitation 
and other forcing data are computed for each catchment. The distribution of water within the 
catchment is not modeled explicitly during each time step. Instead, a unit hydrograph is developed 
to simulate the typical response of the catchment to a uniformly distributed water input event. The 
unit hydrograph is developed for each catchment during the model preprocessing phase. GeoSFM 
contains automated GIS based algorithms for generating these responses. The default procedure 
begins by estimating a uniform overland velocity for each catchment based on the mean slope of the 
catchment and dominant land cover type present. The algorithm also supports the use of non-
uniform velocity grids as well as predetermined uniform velocity values, but these have to be 
supplied by the user. The distance along the flow path from each grid cell in the catchment to the 
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catchment outlet is also computed. The travel time from each grid cell to the catchment outlet is 
also computed as shown in equation 1 below. 
 
 

i

i
i v

l
t =      Equation 1           

 Where: 
 ti is the travel time from a given grid cell to the catchment outlet 
 li  is the flow length from a given grid cell to the catchment outlet 
 vi is the average overland velocity for the catchment  
 
The distribution of discharge at the catchment outlet is given by the probability density function 
(PDF) of travel times in the catchment. The PDF is in essence analogous to the geomorphologic 
instantaneous unit hydrograph (GIUH) of Rodriguez-Iturbe and Valdes (1979). The unit hydrograph 
or probability mass function of flow travel times is obtained by discretizing the PDF over the 
routing interval. Note that the resulting unit hydrograph is only applicable for the particular routing 
interval for which it was defined. Hence a change from a daily routing interval to say a six hourly 
interval would require the definition of a new unit hydrograph response. The unit hydrograph 
response is computed for each catchment during preprocessing and is stored in an ASCII file for 
subsequent use. 
 
Method of Over Land Flow Velocity Computation 
 
 Option 1 –Non –Uniform from USGS Land Cover Grid  
Input Grids/File  Description Unit 
Basins Sub-basin grid assigns a unique ID value to each sub-

basin. 
 

Flowdir Flow direction grid consists of numeric values 
assigned using the eight direction pour point model. 
Each cell is assigned one of eight compass directions. 

 

Flowlen Downstream flow length grid defines the distance 
from the cell to the basin outlet. 

 

Outlets Outlet grid defines number of outlets, one outlet per 
sub-basin, each assigned a unique value. 

 

Usgslandcov USGS Land Cover grid  
Elevations Elevation grid meter 
Flowacc Flow accumulation grid defines the number of 

contributing cells draining into each cell.  Values 
range from 0 at topographic highs to large numbers at 
the mouths of rivers. 

 

Order.txt see .txt file 
detail -1.3 

Computational order file  

Land cover input data used to determine velocity output. 
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 Option 2 –Non –Uniform from User Supplied Velocity Grid  
Input Grids/File  Description Unit 
Basins Sub-basin grid assigns a unique ID value to each sub-

basin. 
 

Flowdir Flow direction grid consists of numeric values 
assigned using the eight direction pour point model. 
Each cell is assigned one of eight compass directions. 

 

Flowlen Downstream flow length grid defines the distance 
from the cell to the basin outlet. 

 

Outlets Outlet grid defines number of outlets, one outlet per 
sub-basin, each assigned a unique value. 

 

Velocity Overland flow user defined velocity grid.  m/s 
Order.txt see .txt file 
detail -1.3 

Computational order file  

The user supplies velocity input grid values. 
 
 
 Option 3 – Uniform from User Supplied Velocity Value 
Input Grids/File  Description Unit 
Basins Sub-basin grid assigns a unique ID value to each sub-

basin. 
 

Flowdir Flow direction grid consists of numeric values 
assigned using the eight direction pour point model. 
Each cell is assigned one of eight compass directions. 

 

Flowlen Downstream flow length grid defines the distance 
from the cell to the basin outlet. 

 

Outlets Outlet grid defines number of outlets, one outlet per 
sub-basin, each assigned a unique value. 

 

Velocity Overland flow velocity value.  m/s 
Order.txt see .txt file 
detail -1.3 

Computational order file  

The user supplies velocity inputs –default values for the velocity of 0.3 m/s for each cell. 
 
 

1.4.1 Landcover Processing (option 1) 

The nature of vegetation on the land surface influences runoff generation and overland flow 
processes. The USGS Global Land Cover Characteristics (GLCC) database (Loveland et al., 1999) 
is used in GeoSFM because of it global coverage. The GLCC data were derived from 1-km 
AVHRR data and are available in the Interrupted Goode Homolosine and Lambert Equal Area 
Azimuthal projections. The data are available for download over the Internet at 
http://edcdaac.usgs.gov/glcc/af_int.html. Land cover data are used along with soils data in the 
determination of SCS runoff curve numbers in GeoSFM. The curve numbers determine the amount 
of incident precipitation that becomes surface runoff. Vegetation also influences the velocity at 
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which this surface runoff is transported over the land surface to the river network. GeoSFM 
contains routines for making a first estimate of overland velocity from the GLCC data and the 
topography.  
 
Downloading USGS Landcover  
 
Download the data from the Internet at http://edcdaac.usgs.gov/glcc/af_int.html. 
 

 
 
This website will bring you to the Land Processes Distributed Active Archive Center –Global Land 
Cover Characterization page, from this page scroll down to the Links to land cover data sets: 
there are two different versions available; select Version 2. 
 
Select appropriate area for download from table shown below.  

GLCC – Version 2 

Global North America Eurasia 

Africa South America Australia Pacific 

 
To complete exercise one outlined in the GeoSFM Training Manual, Africa will be selected. This 
exercise was developed for the Limpopo Basin in southern Africa. Create a new folder in the 
GeoSFM folder called glcc for all of the land cover data. Selecting Africa will display the Africa 
Land Cover Characteristics Data Base Version 2.0 page.   
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Africa Land Cover Characteristics Data Base Version 2.0  

 

Africa Readme 
Africa Land Cover Database Table  
Data in Interrupted Goode Homolosine Projection  
Data in Lambert Azimuthal Equal Area Projection  

From the Africa Land Cover page, select Data in Lambert Azimuthal Equal Area  
Projection.  This will link to a page that contains links to all the documentation files and the image 
files, either compressed or uncompressed.  
 
Scroll down the page to the image files, select 
 
• USGS Land Use/Land Cover Scheme      
 
                                                                                 
  
          Image Files (Download binary ftp files) 
Note: When downloading compressed files, add the .gz extension to the file name.  
 

USGS Land Use/Land Cover Scheme 
compressed 

3.3 Mb  
uncompressed  

77.4 Mb  

 
 
Click on – Compressed/3.3 Mb and save the file, c:\GeoSFM\glcc. Use WinZip to select and 
extract all files to your workspace. From the afusgs2_0l.img.gz.file extract the afusgs2_0l.img.  If 
you do not already have WinZip installed you can download a free trial version from 
http://www.winzip.com/winzip/download.htm.  
 
 Or select  
 
• USGS Land Use/Land Cover Scheme         
                    
 
Click on –UnCompressed/77.4 Mb  
and save the file to your directory, c:\GeoSFM\glcc. 
 

compressed 
3.3 Mb  

uncompressed 
77.4 Mb  
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The downloaded land cover data is provided in a generic image array format (flat, headerless, 
binary raster data) this is to maximize the flexibility for importing the data into a variety of software 
systems. The following procedure is needed before importing these raster image files into ArcView. 
 
Re-name the image file to filename afusgs2_0l.bsq. (.bsq –image file– band sequential) 
 
Next, a header file will need to be created.  
Data fields that are needed for the creation of the header file: 

• nrows – the number of rows in the image 
• ncols – the number of columns in the image 
• nbands – the number of spectral bands in the image –default is 1 
• nbits –the number of bits per pixel per band –default is 8 
• layout –the organization of the bands in the image file –acceptable values bil, bip & bsq 
• skpbytes –the number of bytes of data in the image file to skip to reach start of image data 

(bypass header information) –default is 0 
• ulxmap –the x-axis map coordinate of the center of the upper-left pixel 
• ulymap –the y-axis map coordinate of the center of the upper-left pixel 
• xdim –the x dimension of a pixel in map units 
• ydim –the y dimension of a pixel in map units 

 
The image parameters needed to populate the new header file can be found in the documentation for 
each of the continental data bases.  

 

Lambert Azimuthal Equal Area Projection File Listing 

 

Documentation Files (View ascii ftp files)  
Africa Documentation  
Seasonal Land Cover Region Legend 
Global Ecosystem Legend 
International Geosphere Biosphere Programme Legend 
Biosphere Atmosphere Transfer Scheme Legend 
Simple Biosphere Model Legend 
Simple Biosphere 2 Model Legend 
USGS Land Use and Land Cover Classification Legend 
Vegetation Lifeforms Legend 

Click on Africa Documentation and scroll down to section 2.2 Lambert Azimuthal Equal Area 
Projection Parameters.  
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Items in bold are needed for header file. 

The data dimensions of the Lambert Azimuthal Equal Area projection for the Africa land cover characteristics data set are 
9,276 lines (rows) and 8,350 samples (columns) resulting in a data set size of approximately 77 megabytes for 8-bit 
(byte) images. The following is a summary of the map projection parameters used for this projection: 

Projection Type: Lambert Azimuthal Equal Area  

Units of Measure: meters  

Pixel Size: 1000 meters  

Radius of sphere: 6370997 m  

Longitude of origin: 20 00 00 E  

Latitude of origin: 5 00 00 N  

False easting: 0.0  

False northing: 0.0  

XY corner coordinates (center of pixel) in projection units (meters):  
      Lower left: ( -4458000, -4795000)  

Upper left: ( -4458000, 4480000)  

Upper right: ( 3891000, 4480000)  

Lower right: ( 3891000, -4795000)  

 
Now that you have the data you need, you can prepare an ASCII file.  To do this, open up WordPad 
in Start/Programs/Accessories/WordPad.  
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An example of the WordPad document can be seen below.  Remove the commas from the nrows 
and ncols values.  

 

Save the document from the File menu select Save As… 
File Name –afusgs2_0l.hdr 
Save as Type –Text Document  
Directory –c:\GeoSFM\glcc  
Next, you need to add the land cover data to the ArcView project and convert into a grid for use in 
exercise one as outlined in the GeoSFM Training Model. 

Add the afusgs2_0l.bsq to the View using Add Theme button  from the View menu.  Change 
the Data Source Types to Image Data Source.  Click on the afasgs2_0l.bsq file from the 
c:\GeoSFM\glcc directory and click OK to add the land cover data to the View.  

 
 
The land cover data will not display until it has been converted to a grid. 
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To convert the land cover data to a grid, select the theme afusgs2_0l.bsq so that it appears in a 
raised box.  From the Theme menu select Convert to Grid… 
 

 
 
The Convert Afusgs2_0l.bsq dialog box appears.  Navigate to the c:\GeoSFM\glcc directory and 
type in usgslandcov in Grid Name.  Then click OK. 

 
 
A dialog box appears asking if you would like to Add grid as theme to View.  Click Yes. 
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New usgslandcov theme is shown below. 

 
 
Next, you need to add the Lu_code and description fields to the attribute table.  The values needed 
for these new fields are found in AfricaReadme section 4.4. 
 
Africa Land Cover Characteristics Data Base Version 2.0  

 
 

Africa Readme  

Africa Land Cover Database Table  

Data in Interrupted Goode Homolosine Projection  

Data in Lambert Azimuthal Equal Area Projection 
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4.4 USGS Land Use/Land Cover System Legend (Modified Level 2) 

Value  Code  Description  
1 100 Urban and Built-Up Land 
2 211 Dryland Cropland and Pasture 
3 212 Irrigated Cropland and Pasture 
4 213 Mixed Dryland/Irrigated Cropland and Pasture 
5 280 Cropland/Grassland Mosaic 
6 290 Cropland/Woodland Mosaic 
7 311 Grassland 
8 321 Shrubland 
9 330 Mixed Shrubland/Grassland 
10 332 Savanna 
11 411 Deciduous Broadleaf Forest 
12 412 Deciduous Needleleaf Forest 
13 421 Evergreen Broadleaf Forest 
14 422 Evergreen Needleleaf Forest 
15 430 Mixed Forest 
16 500 Water Bodies 
17 620 Herbaceous Wetland 
18 610 Wooded Wetland 
19 770 Barren or Sparsely Vegetated 
20 820 Herbaceous Tundra 
21 810 Wooded Tundra 
22 850 Mixed Tundra 
23 830 Bare Ground Tundra 
24 900 Snow or Ice 

Value 330 not recognized in model need to add 
Now that you have the data you need, you can prepare an ASCII file.  To do this, open up WordPad 
in Start/Programs/Accessories/WordPad.  Cut and paste data into WordPad. 
 

 

Commas need to be added to separate column values and each line needs to be on a separate row.  
The header and the first line of data also need to be added. 
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The header names added: 

Value, Code, Name 

 Second line was also added: 

0, 0, Unclassified –notice the commas separating field values 

An example of the WordPad document can be seen below.  

 

Save the document, from the File menu select Save As… 

File Name –usgslandcov.txt 
Save as Type –Text Document  
Directory –c:\GeoSFM\glcc  
 
Click on new grid theme so it appears in a raised box.  Click on table icon to open attribute table.  
The table should contain Value and Count fields.   
 

 
 
Next, you need to add the new usgslandcov.txt file that was created.   
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Click on Tables, Add in the project window. 

 
 
The Add Table dialog box will open.  In c:\geosfm\glcc select usgslandcov.txt.  List of Files of 
Type: Delimited Text (.txt) should be displayed.  Click OK. 
 

 
Arrange both tables as seen below.  Click/highlight the common column headers in both tables –
Value in Attributes of usgslandcov and in Value in usgslandcov.txt.  Make the destination table 
active (adding fields to Attributes of usgslandcov).   

 
 
Click on the Join icon, the new columns are added to the Attributes of usgslandcov table. 
 

 
Once the new fields are added to the attribute table you need to make the added data permanent.   
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From the Table menu select Start Editing. 

 
 
Then from the Edit menu select Add field. 

 
 
Two fields will be added.   
Field One: 
Name: Lu_ Code 
Type: Number 
Width: 3 
Decimal Places: 0  

 
 
After Field Definition is populated click OK. 
 
Field Two: 
Name: Description 
Type: String 
Width: 50 
Decimal Places: 0 

 
 
After Field Definition is populated click OK. 
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Next, you will populate the column values for the new fields by using the Field Calculator icon on 
the tool bar.     Click on the Field Calculator icon. 
 

 
 
The Field Calculator dialog box opens – double click [Code] under Fields. 
Calculation reads → [Lu_code] = [Code], as seen below.  Click OK. 
 

 
 
The new Lu_code fields are populated with the same values as the Code fields. 
 
Click on the Field Calculator again to populate the Description column fields. 

 
 
The Field Calculator dialog box opens – double click [Name] under Fields. 
Calculation reads → [Description] = [Name].  Click OK. 
The new Description fields are populated with the same values as the Name fields. 
  
Next, you will remove the join leaving Value, Count, Lu_code, and Description fields. 
From the Table menu select Remove All Joins.   
 
From the Table menu select Save Edits.  Click Yes. 
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From the Table menu select Stop Editing.  Click Yes. 

 
 
The USGS Land Cover grid can be added to the View when prompted during the Method of 
OverLand Flow Velocity Computation process in section 1.6 in the GeoSFM Training Manual. 
 

1.4.2 Basin Response Outputs 

 
Output Grids/File  Description 
Traveltime  Travel time from each grid cell to the catchment outlet based on 

slope, watershed size, flow resistance (Manning’s roughness 
coefficient), and water input. 

Velocity Option 1-Estimated uniform overland velocity for each catchment 
based on the mean slope of the catchment and dominant land 
cover.   
Option 2-Velocity values for each catchment defined by user. 
Option 3-Velocity default value for each catchment defined by 
user. 

response.txt 
see .txt file detail 
below 

File containing fraction of excess runoff arriving at sub-basin 
outlet in each subsequent time step, similar to a unit hydrograph 
for each sub-basin. 

 
 
response.txt 
Parameters 

Description Units Range of 
Values 

BasinID BasinID of sub-basin beginning with the 
most downstream 

 1-366 

 ↓   
 Most upstream sub-basin   
Day 0 Fraction of excess runoff arriving at sub-

basin outlet in each subsequent time step 
 0.0-1.0 

Day 1 ↓   
Day 2    
↓    
Day 20    
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2.0 Performing Stream Flow Analysis 

 

2.1 Generate Rainfall and Evapotranspiration Files 

 
NOAA Satellite Rainfall Estimates (RFE)  
Precipitation data is the most essential input to any hydrologic model, and in the case of the 
GeoSFM, it was the driving factor in the design of the model and the wide monitoring system. In 
order to accurately simulate stream flow conditions on the ground, the most precise source of 
precipitation data with near global coverage had to be used. Ground based gauges are widely 
considered to provide the most accurate measure of precipitation at any location. However, the 
spatial coverage of ground based gauges is very poor in many regions of the world and is therefore 
inadequate to support hydrologic modeling needs. While global climate models can be run 
operationally to generate precipitation globally, the accuracy of the resulting precipitation fields is 
insufficient to support hydrologic modeling efforts. The Climate Prediction Center (CPC) of the 
National Oceanic and Atmospheric Administration (NOAA) uses satellite images in conjunction 
with ground based gauges to process rainfall estimates on a daily basis. These satellite derived 
rainfall estimate, commonly known by the abbreviation RFE, can be generated for most parts of the 
world since weather satellites have global coverage. The inclusion of ground observations in these 
rainfall estimates provides a means of ground-truthing satellite observations on a daily basis thus 
minimizing inaccuracies in the estimate.   
 
The theoretical basis for satellite rainfall estimation derives from the fact that rainfall forms when 
moisture in the atmosphere is cooled to condensation. In the absence of condensation nuclei, 
moisture condenses at temperatures of 235 Kelvin and below. By monitoring the temperature of 
cloud tops from infrared imagery from geostationary satellites such as Meteosat 7, scientists are 
able to determine areas where moisture condensation and consequently rainfall is occurring. 
Infrared satellite imagery gives a good indication of the spatial distribution of convective rainfall. 
Microwave imagery from sensors such as the Special Sensor Microwave/Imager (SSM/I) of 
Defense Meteorological Satellite Program and the Advanced Microwave Sounding Unit (AMSU) 
from NOAA are also incorporated to identify other types of non-convective rainfall. However, 
satellite imagery do not give a good indication of the rainfall rate, and consequently, other sources 
of rainfall rate information must be incorporated in order to calculate a daily rainfall accumulation.  
 
The World Meteorological Organization (WMO) collects and archives weather information 
(including rainfall accumulations) from around the world on a daily basis. National meteorological 
agencies throughout the world obtain readings of weather conditions for the previous 24 hours 
through their network of ground-based synoptic weather stations. These data are transmitted daily 
through WMO’s Global Telecommunications System (GTS) to a central archive, and a consolidated 
archive documenting global weather conditions is redistributed via the same system to the member 
countries. Barring any transmission errors, these data provide an accurate assessment of the quantity 
of rainfall at selected points throughout the world. However, there are not enough stations in the 
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GTS system to support hydrologic modeling in most parts of the world. By combining observed 
rainfall from the GTS system with satellite rainfall estimates, scientists at NOAA have produced an 
RFE product which captures both the spatial and quantitative distribution of rainfall. The resulting 
RFE product has a spatial resolution of 8-kilometers and can be produced for virtually any part of 
the world. 
 
USGS Potential Evapotranspiration (PET) Data 
Evapotranspiration is one of the important processes by which water is extracted from the soil 
column. While the rate of evapotranspiration depends on the amount of water present in the soil 
column, the maximum extraction rate (also called potential evapotranspiration, PET) depends on 
prevailing weather conditions including temperature, fluxes of long and short wave radiation, 
atmospheric pressure, relative humidity and wind speed. There are several equations for computing 
PET, the most comprehensive of which is the Penman-Monteith equation. Data from the Global 
Data Assimilation System (GDAS) is used to solve the Penman-Monteith equation to generate grids 
of PET at a daily time step. GeoSFM contains procedures for ingesting the resulting PET grids and 
computing actual daily evapotranspiration based on antecedent soil moisture conditions. 
 
 
Input Grid/File Description Unit 
Basins Basin Grid  
order.txt see .txt file detail -
1.3 

Computational order file  

 
 
Rain and Evap Input Parameters 
Input Parameters Description Unit 
raindata Rain data from directory mm 
evapdata Evap data from directory tenths of 

mm 
Start Year Start year of data  
End Year End year of data  
Start Day Number Start day of data –defaults 1– Julian Date  
End Day Number End day of data –number of days included  for 

data estimate –defaults -240- entered 10 (for 
shorter processing time) – Julian Date 

 

 
 

2.1.1 Rain and Evapotranspiration Output Files 

 
Rain and Evap Output Data for Each Sub-Basin 
Output Files Description 
rain.txt 
see .txt file detail 

File containing time step rainfall (mm) for each sub-basin (per 
day) 



 

 96

below 
evap.txt see .txt file 
detail below 

File containing time step PET (tenths of mm) for each sub-basin 
(per day) 

 
rain.txt  
Parameters 

Description Units Range of 
Values 

Time Date – example 1999001 – format 
yyyyddd   

 1999001-
1999010 

                                 ↓   
 Date                   1999010   
BasinID of sub-
basin beginning 
with the most 
downstream 

time step rainfall for each sub-basin mm 0.0 – 54.6 

↓    
Most upstream sub-
basin 

   

 
 
evap.txt 
Parameters 

Description Units Range of 
Values 

Time Date – example 1999001 – format 
yyyyddd   

 1999001 – 
1999010 

                                 ↓   
 Date                   1999010   
BasinID of sub-
basin beginning 
with the most 
downstream 

time step PET for each sub-basin Tenths 
of mm 

26-72 

↓    
Most upstream sub-
basin 

   

 
 
 
 

2.2 Compute Soil Water Balance 

 
As a continuous simulation model, GeoSFM contains routines for computing soil moisture 
conditions on a daily basis. The soil parameters required by the model are extracted for each 
catchment from the FAO Soil Map described in section 1.3. Two Soil Moisture Accounting 
routines, using single and double soil layers respectively, have been coded in a mixed programming 
environment and compiled into dynamic link libraries (DLL). Avenue code has been rewritten to 
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call up and execute the DLL routines from within ArcView. The user is consequently able to 
perform SMA runs from within the GIS environment. The features of the respective single and 
double layer models are described below. 
 
The single layer soil model is a simple bucket model with partial contributing area for Hortonian 
surface runoff generation. In essence, the soil column is modeled as a single control volume with 
rainfall as the only input and evapotranspiration, subsurface runoff and deep ground water 
percolation as the only outputs. A fraction of incident rainfall becomes surface runoff before 
entering the control volume. The magnitude of this fraction is directly proportional to the fraction of 
the control volume that is filled with water. A simple soil moisture accounting method is used to 
track the moisture in the control volume during each simulation time step. The only parameters that 
need to be estimated are water holding capacity of the control volume, the response times for 
interflow and base flow extraction and the rate of percolation to deep ground water. The relatively 
simplicity of this model lends itself to implementation in data scarce wide-area applications. A 
significant limitation of this approach is that the type and condition of land cover within a 
catchment is not taken into account. 
 
The two layer soil model provides a more complete representation of subsurface processes by 
creating separate soil layers within which interflow and base flow processes occur. Soil 
Conservation Service (SCS) runoff curve number method (which takes vegetation and soil type into 
account) is used for separating runoff into surface and interflow components while the Green-Ampt 
equation is used for extracting water from the interflow soil layer to feed the base flow soil layer. In 
addition to the parameters from the single layer model, parameters describing the fraction of the soil 
column that is attributable to the respective interflow and base flow layers, SCS curve numbers and 
Green-Ampt parameters are required for the two layer model. The superior representation of land 
surface and soil moisture processes makes the two layer model better suited for application in areas 
where finer resolution data is available to support its parameterization.  
 
Irrespective of the choice of soil moisture accounting model, GeoSFM generates a series of ASCII 
files containing the fluxes from the respective surface, interflow, base flow and deep percolation 
phases of flow as well as the soil moisture storage. The output files are formatted for ingestion by 
the channel routing routines in GeoSFM. 
 
 
 
 
 
 
Rain, Evap, Basin and Response Input Data 
Input Files Description 
rain.txt see .txt file 
detail -2.1 

File containing time step rainfall (mm) for each sub-basin 

evap.txt see .txt file 
detail -2.1 

File containing time step PET (tenths of mm) for each sub-basin 

basin.txt see .txt file 
detail -1.3 

File containing each sub-basin characteristics 
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response.txt see .txt 
file detail -1.4 

File containing time step excess runoff arriving at sub-basin outlet 

 
Input Data – Selection of Single or Double Layer Soil Model 
Input Parameters Description Unit 
Computation Start Year Year entered into field  
Computation Start Day Day --- default 001- Julian Date  
Number of Rain/Evap Days Days --- default 10  
Number of Response Days Days --- default 21 (how long the hydrograph 

is stretched)  
 

Number of Sub-basins Number --- default 365  
Initial Soil Moisture  Assume soil is dry containing only 10% of its 

storage capacity ---- default 0.1 (decimal) 
 

Data Format (l for Daily 
Data) 

  1 = Day  ---- default 1.0 
  0 = Hourly 

 

New Run or Continue 
Previous Run 

0 = New run – default 0 – 
1 = Continue previous run  

 

Basin Polygon Theme Polygon of analysis area – selected 
basply.shp for exercise 

 

Key Field e.g. Grid Code Selected gridcode for exercise–number ID  
Mode 0=Simulation, 1=Calibration   -defaults-0   
Soil Model Option of Single Layer Soil Model or Double 

Layer Soil Model ---selected Single Layer for 
exercise 

 

 

2.2.1 Soil Water Balance Outputs 

 
Output parameters 
Output Files Description 
balparam.txt  see .txt 
file detail below 

File containing: Number of ordinates of unit hydrograph response, 
number of simulation time steps, simulation start year/day, number 
of catchments, simulation interval in hours, data format, model 
initialization code, and initial soil fraction. 

balfiles.txt see .txt 
file detail below 

File listing input and output .txt files 

 
Soil Moisture Output Data 
Output Files Description 
basinrunoffyield.txt 
see .txt file detail 
below 

Basin runoff yield –runoff for each sub-basin 

soilwater.txt see .txt 
file detail below 

Output soil moisture storage  

actualevap.txt see Actual evapotranspiration (mm) 
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.txt file detail below 
gwloss.txt see .txt 
file detail  

Output file water lost to the regional groundwater flow 

cswater.txt see .txt 
file detail below 

Output file containing last model time step simulated soil water 
content (mm) 

excessflow.txt see 
.txt file detail below 

Output file excess runoff fluxes (mm) 

interflow.txt see .txt 
file detail below 

Output file interflow or fast base flow fluxes (mm) 

baseflow.txt see .txt 
file detail below 

Output file base flow fluxes (mm) 

logfilesoil.txt see .txt 
file detail below 

Process/Error Log File 

massbalance.txt see 
.txt file detail below 

Output file of sum of water cycle components for the total 
simulation period (mm) –only for Double Layer Soil Model  

initial.txt see .txt file 
detail below 

Input/output file that contains initial conditions for model state 
variables –only if Double Layer Soil Model is selected 

default.txt see .txt 
file detail below 

Soil model and routing configuration selected for model run. 

 
 
 
 
 
balparam.txt 
Parameters 

Description Units Range of 
Values 

No headers Number of ordinates of unit 
hydrograph response 

 13 

 Number of simulation time steps  10 
 Simulation start year  1999 
 Simulation start day  001 
 Number of catchments  355 
 Simulation interval in hours  24 
 Data format indicator (1/0) –defaults 1  0-1 
 Model initialization mode (1/0) –

defaults 0 
 0-1 

 Initial soil fraction  0.1 
 
 
balfiles.txt 
Parameters 

Description 

No header Input rainfall file (rain.txt) 
 Input potential evapotranspiration file (evap.txt) 
 Input basin characteristics file (basin.txt) 
 Input unit hydrograph response file (response.txt) 
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 Output balance parameter file (balparam.txt) 
 Output runoff yield file (basinrunoffyield.txt) 
 Output soil moisture storage file (soilwater.txt) 
 Output actual evapotranspiration file (actualevap.txt) 
 Output ground water loss file (gwloss.txt) 
 Output final soil water storage file (cswater.txt) 
 Output surface precipitation excess file (gwloss.txt) 
 Output interflow file (interflow.txt) 
 Output baseflow file (baseflow.txt) 
 Output mass balance file (massbalance.txt) 
 Output log file (logfilesoil.txt) 
 Output initialization file (initial.txt) 
 Output workdirectory (<full directory pathname>) 
 
 
 
 
 
 
 
 
 
 
 
basinrunoffyield.txt 
Parameters  

Description Units Range of 
Values 

Time Date – example 1999001 – format 
yyyyddd   

 1999001 – 
1999110 

                                 ↓   
 Date                   1999110   
BasinID of sub-basin 
beginning with the 
most downstream 

Time step runoff for each sub-basin. mm 0.01-3.05 

↓    
Most upstream sub-
basin 

   

 
 
soilwater.txt 
Parameters 

Description Units Range of 
Values 

Time Date – example 1999001 – format 
yyyyddd  (first column) 

 1999001 – 
1999110 

                                 ↓   
 Date                   1999110   
ID of sub-basin Time step soil moisture storage for  0.8-69.9 
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beginning with the 
most downstream 

each sub-basin 

↓    
Most upstream sub-
basin 

   

 
 
actualevap.txt 
Parameters 

Description Units Range of 
Values 

Time Date – example 1999001 – format 
yyyyddd  (first column) 

 1999001 – 
1999110 

                                 ↓   
 Date                   1999110   
ID of sub-basin 
beginning with the 
most downstream 

Time step for actual 
evapotranspiration for each sub-basin 

mm 0.001-5.1 

↓    
Most upstream sub-
basin 

   

 
 
 
 
 
 
gwloss.txt 
Parameters 

Description Units Range of 
Values 

Time Date – example 1999001 – format 
yyyyddd  (first column) 

 1999001 – 
1999110 

                                 ↓   
 Date                   1999110   
ID of sub-basin 
beginning with the 
most downstream 

Time step water lost to the regional 
groundwater flow for each sub-basin 

 0-33.1 

↓    
Most upstream sub-
basin 

   

 
 
cswater.txt 
Parameters 

Description Units Range of 
Values 

Basin ID ID of sub-basin beginning with the 
most downstream 

  

 ↓   
 Most upstream sub-basin   
CurrentSW Contains last model time step mm 2.9-102.1 
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simulated soil water content  
 
 
excessflow txt 
Parameters 

Description Units Range of 
Values 

Time Date – example 1999001 – format 
yyyyddd  (first column) 

 1999001 – 
1999110 

                                 ↓   
 Date                   1999110   
ID of sub-basin 
beginning with the 
most downstream 

Time step of excess runoff fluxes  mm 0-3.8 

↓    
Most upstream sub-
basin 

   

 
 
 
 
 
 
 
 
 
 
interflow.txt 
Parameters 

Description Units Range of 
Values 

Time Date – example 1999001 – format 
yyyyddd  (first column) 

 1999001 – 
1999110 

                                 ↓   
 Date                   1999110   
ID of sub-basin 
beginning with the 
most downstream 

Time step of interflow or fast base 
flow fluxes  

mm 0-1.9 

↓    
Most upstream sub-
basin 

   

 
 
baseflow.txt 
Parameters 

Description Units Range of 
Values 

Time Date – example 1999001 – format 
yyyyddd  (first column) 

 1999001 – 
1999110 

                                 ↓   
 Date                   1999110   
ID of sub-basin Time step base flow fluxes  mm 0.001-0.23 
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beginning with the 
most downstream 
↓    
Most upstream sub-
basin 

   

 
 
logfilesoil.txt 
Parameters 

Description Units Range of 
Values 

 Process/Error Log File   
 
 
default.txt Description Units Range of 

Values 
No header Soil configuration selected for model 

run. 
Soil1 – Single layer soil model 
Soil2 –Double layer soil model 

  

 Routing method selected for model 
run. 
Rout1 –Simple Lag Routing Method 
Rout2 –Diffusion Analog Routing 
Method 
Rout3 –Mushingum Cunge Routing 
Method 

  

 
Additional Output for Double Layer Soil Model 
massbalance.txt 
Parameters 

Description Units Range of 
Values 

basinId ID of sub-basin beginning with the 
most downstream 

 1-366 

 ↓   
 Most upstream sub-basin   
precipitation Sum of water cycle precipitation for 

the total simulation period. 
mm 7-122 

surfaceRunoff Sum of water cycle surface runoff for 
the total simulation period. 

mm 0-5 

interflow Sum of water cycle fast base flow flux 
for the total simulation period. 

mm 0 

baseflow Sum of water cycle base flow flux for 
the total simulation period. 

mm 0 

evaportation Sum of water cycle evaporation for the 
total simulation period. 

mm 0-18 

moisture_change Difference of the water cycle value 
from start of model to end of model for 
the total simulation period. 

mm 14-174 
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residual Difference of water cycle (rain in, 
evaporation/runoff out) for the total 
simulation period. 

mm 0-14 

 
 
 
 
 
 
 
 
Additional Output for Double Layer Soil Model 
initial.txt Parameters Description Units Range of 

Values 
Basin ID ID of sub-basin beginning with the 

most downstream 
 1-366 

 ↓   
 Most upstream sub-basin   
upperSoilWater Upper soil water values for each sub-

basin. 
  

lowerSoilWater Lower soil water values for each 
sub-basin. 

  

fastBaseflow Fast base flow values for each sub-
basin. 

  

slowBaseflow Slow base flow values for each sub-
basin. 

  

interflowWater Interflow reservoir water values for 
each sub-basin. 

  

upperSoilExcessWater Upper soil excess water values for 
each sub-basin. 

  

lowerSoilExcessWater Lower soil excess water values for 
each sub-basin. 

  

surfaceWaterAtTime0 Surface water value at first time step 
of hydrograph for each sub-basin. 

  

surfaceWaterAtTime1 Surface water value at next time step 
of hydrograph for each sub-basin. 

  

surfaceWaterAtTime2 Surface water value at next time step 
of hydrograph for each sub-basin. 

  

↓ ↓   
surfaceWaterAtTime19 Surface water value at next time step 

of hydrograph for each sub-basin 
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2.3 Compute Stream Flow 

 
When runoff generated within a given catchment arrives at the catchment outlet, it enters the river 
network and works its way downstream to the basin outlet. There are a variety of linear and non-
linear routing methods for simulating the in-channel phase of flow. GeoSFM supports two linear 
methods namely pure translation and the diffusion analog, and one non-linear method, the 
Muskingum Cunge.  
 
The pure translation approach is the simplest of the routing approaches. It accounts for the 
advection of flow but does not include any attenuation or deformation of the input. Consequently, 
the input flow remains unaltered in magnitude at the discharge point, and a single flow parameter 
namely travel time between the input and discharge locations is required for the computation. 
Mathematically, pure translation routing can be expressed as follows: 
Equation 2 

)'()( ttItQ −=  
where Q(t) is the discharge at time, t 
 t’ is the travel time between input and discharge locations and 
 I(t-t’) is the input at time (t-t’) 
 
The diffusion analog method is a linear routing method which accounts for both flow advection and 
attenuation. It includes one parameter for flow translation (flow time or celerity) and another for the 
attenuation or spreading out of flow (dispersion coefficient). The diffusion analog equation is fact 
the linear solution of the Advection-dispersion equation (also known as the Navier-Stokes equation 
for a plane rectangular source). Mathematically, the diffusion analog equation can be expressed as 
follows: 
Equation 3 
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where 
 D is the dispersion coefficient in m2/s 
 V is the flow celerity in m/s 
 x is the distance from the origin in m 
 t is the time elapsed since the input in seconds 
 π is the numerical constant Pi and has a value of 3.14159 
 Q(x,t) is the discharge at time t at a distance x from the origin  
 I(0,0) is the input at time zero at the origin 
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The Muskingum Cunge is a non-linear, variable parameter routing method. Like the linear 
Muskingum routing method, it involves the use of the continuity equation and an empirical storage 
equation. It relies on the Muskingum K coefficient (analogous to flow time) to control the rate of 
advection and the Muskingum x coefficient to control the rate of attenuation or spreading out. 
Cunge proposed to amend the method by allowing the Muskingum x coefficient to vary during each 
time step based on the condition of flow at the previous time step. In effect, the rate of attenuation 
of flow is dependent on the condition of flow. Mathematically, Muskingum Cunge routing can be 
expressed as follows: 
Equation 4 
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Equation 5 
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where 
 K is the Muskingum K coefficient in seconds 
 X is the dimensionless Muskingum X coefficient  
 c is the average flood wave celerity in m/s 
 B is the average channel width in m 
 Se is the dimensionless friction slope 
 x is the length of the channel 
 S is the storage in the channel at time t in m/s 
 I is the inflow in m/s 
 Q is the discharge in m/s 
 
All catchments within the analysis area are parameterized for the three routing methods during 
preprocessing such that the user can opt for any of the three methods just prior to execution without 
additional preprocessing.  
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Stream Flow Input Data 
Input Files Description 
basinrunoffyield.txt see .txt 
file detail -2.2 

Basin Runoff Yield File 

response.txt see .txt file 
detail -1.4 

File containing time step excess runoff arriving at sub-basin 
outlet 

river.txt see .txt file detail -
1.3 

File containing river characteristics 

reservoir.txt see .txt file 
detail below 

Reservoir Characteristic File 

rating.txt see .txt file detail 
below 

Stream gauge input containing BasinID, type, parameters 
and maximum river depth. 

 
 
Input Data –Selection of Routing Method 
Input Parameters Description Units 
Basin Polygon Theme Polygon of analysis area – selected 

basply.shp for exercise 
 

Key Field eg Grid Code Selected gridcode for exercise  
Number of Days of Forecast 
Required 

Default  - 3  

Mode 0=Simulation, 1=Calibration  -default 0-  
Routing Method Needed for the computation –three options 

Simple Lag Routing Method, Diffusion 
Analog Routing Method, or Muskingum 
Cunge Routing Method – selected Simple 
Lag Routing Method for exercise 

 

 
 
Input Data for Stream Flow Routing if dams exist 
reservoir.txt 
Parameters 

Description Units Range of 
Values 

DamID Basin Id where dam is located.   
Storage Storage in 1000m3   
Residence Time Defaults 30   
Operated 0 –No user defined file 

1 –User defined file used 
 0, 1 

OpFilName 
 

Path and file name if user defined file 
is used. Defaults -None 

  

 
 
Input only when stream gauges are used in streams 
rating.txt Description Units Range of 

Values 
BasinID BasinID of sub-basin beginning with   
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the most downstream 
 ↓   
 Most upstream sub-basin   
Type Two different types based on the 

following equations: 
Type1 – Q = A(H+B)^C 
Type 2 –Q = (A*H^2)+ BH + C 
 
where: A= Par1 
            B= Par2 
            C= Par3 

Q =m^3/sec 
(flow) 
 
H = m  
(height) 

1, 2 

Par1 Equation Parameter for “A”   
Par2 Equation Parameter for “B”   
Par3 Equation Parameter for “C”   
hmax Maximum height where equation is 

valid. 
  

 
 
 
Creating a Reservoir Characteristic File – reservoir.txt 
 
If there are any dams on a river or stream within the basin you will need to create a reservoir file.  
On the toolbar select the dam icon. 

 
 
The curser will change symbols, position your mouse on the stream containing the dam. Left click 
your mouse and a Dams shapefile will be added to your project. In the first dialog box displayed, 
select the Basins grid from the drop down list.  Click OK. 

 
 
Next, you will enter the reservoir parameters.  The Dam ID will populate with the Basin Id of the 
selected point on the stream.  The Storage value is needed along with the Residence Time in days.  
The Operated field is populated with either a 0 or 1 depending on a user defined file. (0 if no file, 1 
if there is a file.) If the file is needed the file path and name will be populated in the Operation 
FileName field.  Click OK. 
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Dam added to the View.  This process will create a reservoir.txt file. 

 
Creating a Stream Gauge File – rating.txt 
 
If you need to input stream flow data from stream gauges the data will need to be in a format as the 
file below.  The first column header is BasinID, starting with the most downstream basin. The next 
column header is Type here you will populate with either a 1 or 2 depending on which equation you 
will be using.  The next three column headers are the three different equation parameters –Par1, 
Par2, and Par3.  The last column is hmax which is populated with the maximum flow height where 
the equation is valid. Create your file using Excel.   
 
Example rating.txt - 

 
 
To save the file select File and Save As…  
File name: “rating.txt” 
Save as type: CSV (Comma delimited) (*.csv) 
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2.3.1 Stream Flow Routing Outputs 

 
Output from Routing Method 
Output Files Description 
routparam.txt see .txt file 
detail below 

File containing: number of simulation time steps, 
simulation start year/day, number of catchments, 
simulation interval in hours, model type, number of 
forecast days, model initialization mode, number of 
reservoirs 

routfiles.txt see .txt file 
detail below 

File listing input and output .txt files 

 
 
 
 
 
 
 
Stream Flow Routing Output files 
Output Files Description 
  
inflow.txt see .txt file detail 
below 

Flow values coming from upstream for each sub-basin. 

streamflow.txt see .txt file 
detail below 

Stream flow file contains a time series of velocity values in 
cubic meters per second for each sub-basin. 

localflow.txt see .txt file 
detail below 

Flow value generated in each sub-basin. 

riverdepth.txt see .txt file 
detail below 

River depth file populates when Muskingum Cunge 
Routing Method is selected. 

diffresponse.txt  see .txt file 
detail below 

Output file …….–only  if Diffusion Analog Routing 
Method is selected 

damstatus.txt see .txt file 
detail below 

Reservoir status file –only if there are dams in sub-basin 

damlink.txt see .txt file 
detail below 

Dam link file –only if there are dams in sub-basins 

forecast.txt see .txt file 
detail below 

 

obsflow.txt see .txt file  
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detail below 
times.txt see .txt file detail 
below 

Start/end time and date of computing stream flow process. 

logfileflow.txt see .txt file 
detail below 

Process/Error log file. 

 
 
routparam.txt 
Parameters 

Description Range of 
Values 

No Header Number of simulation time steps 10 
 Simulation start year 1999 
 Simulation start day 001 
 Number of catchments 365 
 Simulation interval in hours 24 
 Model type (0=Musk-Cunge, 1=Linear Reservoir) 0,1 
 Number of forecast day 3 
 Model initialization mode (1/0) 1 
 Number of reservoirs 0 
 
 
 
routfiles.txt 
Parameters 

Description 

No Header Route parameter file (routparam.txt) 
 Input river characteristics file (river.txt) 
 Input river initialization file (initial.txt) 
 Input runoff yield file (basinrunoffyield.txt) 
 Input reservoir-river link file (damlink.txt) 
 Input observed flow file (obsflow.txt) 
 Input rating curve flow file (rating.txt) 
 Output streamflow file (streamflow.txt) 
 Output sub-basin flow contribution file (localflow.txt) 
 Output average river depth file (riverdepth.txt) 
 Output sub-basin upstream flow contribution (inflow.txt) 
 Output flow routing log file (logfileflow.txt) 
 Output work directory (<full directory pathname>) 
 
 
inflow.txt 
Parameters 

Description Units Range of 
Values 

Time Date – example 1999001 – format 
yyyyddd   

 1999001 – 
1999013 

                                 ↓   
 Date                   1999013   
BasinID of sub- Upstream flow values for each sub-  0-1470 
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basin beginning 
with the most 
downstream 

basin. 

↓    
Most upstream sub-
basin 

   

 
 
streamflow.txt 
Parameters 

Description Units Range of 
Values 

Time Date – example 1999001 – format 
yyyyddd   

 1999001 – 
1999013 

                                 ↓   
 Date                   1999013   
BasinID of sub-
basin beginning 
with the most 
downstream 

Time step total discharge for each sub-
basin 
 

m3/s 0.279-
1471.28 

↓    
Most upstream sub-
basin 

   

 
localflow.txt 
Parameters 

Description Units Range of 
Values 

Time Date – example 1999001 – format 
yyyyddd   

 1999001 – 
1999013 

                                 ↓   
 Date                   1999013   
BasinID of sub-
basin beginning 
with the most 
downstream 

Flow value generated in each sub-
basin. 

 .001-
148.293 

↓    
Most upstream sub-
basin 

   

 
forecast.txt Description Units Range of 

Values 
Time    
BasinID of sub-
basin beginning 
with the most 
downstream 

   

↓    
Most upstream sub-
basin 
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obsflow.txt Description Units Range of 

Values 
    
    
    
 
 
times.txt Description 
No header Starting time: Day of the week, month/day, hour/minute/second, 

year. 
Ending time: Day of the week, month/day, hour/minute/second, 
year. 
Example – Fri Oct 28 16:49:59 2005 

 
 
logfileflow.txt Description 
No header File history. 
 ***CREATED LOGFILEFLOW.TXT FILE*** 

 ****READ ROUTFILES.TXT **** 
 ***OPENED ROUTPARAM.TXT FILE*** 
 ****READ ROUTPARAM.TXT **** 
 ***OPENED RIVER.TXT FILE*** 
 ***OPENED BASINRUNOFFYIELD.TXT FILE*** 
 ***CREATED INFLOW.TXT FILE*** 
 ***CREATED STREAMFLOW.TXT FILE*** 
 ***OPENED DAMLINK.TXT FILE*** 
 ***CREATED LOCALFLOW.TXT FILE*** 
 ****READ BASIN FILE HEADER**** 
 ****READ RUNOFF FILE HEADER**** 
 ****READ BASIN FILE**** 
 ****READ BASIN RUNOFF YIELD FILE**** 
 ****INITIATING ROUTING**** 
 ***WRITING OUTPUT FILES*** 
 ***CLOSING TIME SERIES FILES*** 
 ***RETURNING TO ARCVIEW*** 

 
 
 
 
 
Additional Output for Muskingum Cunge Routing Method 
riverdepth.txt 
Parameters 

Description Units Range of 
Values 

Time Date – example 1999001 – format 
yyyyddd  (first column) 
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                                 ↓   
 Date                   1999013   
BasinID of sub-
basin beginning 
with the most 
downstream 

Time step river depth for each sub-
basin. 

m 0.01 – 16.55 

↓    
Most upstream sub-
basin 

   

 
Additional Output for Diffusion Analog Routing Method 
diffresponse.txt Description Units Range of 

Values 
 14 columns of data   
Could not re-
create 8/11 

   

    
 
Output only if dams are present in sub-basins 
damstatus.txt 
Parameters 

Description Units Range of 
Values 

    
    
 
 
 
Output only if dams are present in sub-basins 
damlink.txt Description Units Range of 

Values 
    
    
 
 
 
 
 
 
 
 
 
 
 



 

 115

3.0 Calibration  

3.1 Perform Sensitivity Analysis 

Sensitivity analysis (SA) serves a dual purpose of testing which sensitive parameters should be used 
for calibration as well as analyzing feasible parameter ranges.  The goal of SA is to see if there is a 
change in model results when the parameter values are changed. The program SArun.exe tests 
twenty input parameters over user specified ranges.  It takes a total of 400 model runs to complete 
the SA test.  The SA result can be used to tests the model structure, if parameters assumed to have a 
strong impact on model results do not show any sensitivity, the model structure should be 
reassessed.  The SA can give a clear understanding of the feasible parameter space.  If the SA 
results show a parameter to be too sensitive or not sensitive at all, it may be that the parameter range 
must be refined.  Getting the minimum and maximum parameter space refined as much as possible 
using realistic values for the specific watershed one is modeling is imperative for realistic 
calibration results. 
 
Input Parameters Description 
River Reach Drop down list of river reach –selected 140 for exercise 4 
Model Configuration Drop down list of all possible model configurations – soil/routing.  Selected 

one soil layer, lag routing for exercise 4. 

 
Multiplier Range for Sensitivity Parameters --populates range.txt 
Name Description Unit Default 

Value 
Min/Max 

soilwhc Soil water holding capacity mm 1,600 
depth Total soil depth cm 1,800 
texture Soil texture: 1=sand, 2=loam, 3=clay, 5=water  1,5 
Ks Saturated hydraulic conductivity cm/hr 0.001,150 
Interflow Interflow storage residence time days 1,365 
Hslope Average sub-basin slope  0.001,10 
Baseflow Baseflow reservoir residence time days 1,365 
Curvenum SCS runoff curve number  25,98 
Maxcover Permanently impervious cover fraction  0.01,1 
Basinloss Fraction of soil water infiltrating to ground water  0.01,0.5 
PanCoeff Pan coefficient for correcting PET readings  0.6,0.95 
Topsoil Fraction of soil layer that is hydrologically active  0.05,1 
raincalc Excess rainfall mode 1=Philip, 2=SCS, 3=BucketModel  3 
rivrough River Channel Roughness Coefficient (Manning n)  07 
rivslope Average slope of the river  0.001,10 
rivwidth Average channel width m 1,1000 
rivloss Fraction of flow lost within the river channel  0.01,0.5 
rivfploss Fraction of the river flow lost in floodplain  0.01,0.5 
Celerity Flood wave celerity m/s 0.1,5 
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diffusion Flow attenuation coefficient m^2/s 100,10000 
 
 
Input Files Description 
range.txt 
see above table 

Provides minimum and maximum values of a feasible parameter range for 
testing model sensitivity. 

balparam.txt 
see section 2.2 

File containing: Number of ordinates of unit hydrograph response, number 
of simulation time steps, simulation start year/day, and number of 
catchments, simulation interval in hours, data format, model initialization 
code, and initial soil fraction. 

basin_original.txt 
see section 1.3 

Original basin characteristics. 

basin.txt  see section 
1.3 

File containing each sub-basin characteristics.  This file is rewritten during 
the sensitivity analysis process. 

river_original.txt see 
section 1.3 

Original river characteristics. 

river.txt see section 
1.3 

File containing river characteristics.  This file is rewritten during the 
sensitivity analysis process. 

moscem_param.txt 
see .txt file detail 
below 

Gives location of outlet in model output file. 

whichmodel.txt see 
.txt file detail below 

Sets choice of water balance and routing model configurations. 

 
 
Moscem_param.txt 
parameters 

Parameter Description Range of 
Values 

No header Nflux Number of output variables (fluxes). 1 
 Ntstep1 Number of time steps of input variables. 10 
 Nstep2 Number of time steps of output variables. 10 
 Obj_func Statistical test: 

1 = “RMSE” root mean square error function 
2 = “STD” standard deviation 
3 = “HMLE” maximum likelihood error 
function 
4 = “NSE” Nash-Sutcliffe efficiency 
5 = “NSC” Number of sign changes 
6 = “BIAS” 

1 

 Missing Value Value of missing data in 
observed_streamflow.txt. 

-9999 

 Nflux_obs Column in observed_streamflow.txt to test. 1 
 Nflux_model Column in streamflow.txt to extract modeled 

data 
10 
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whichModel.txt  
parameters 

Description Range of 
Values 

Model Index Models: 
Water balance model 
Routing model 

1-3 

Index Description Water balance model – 1=1D balance, 2=2Dbalance  
 Routing model –1=diffusion, 2=Muskingham-Cunge, 3=lag  
 
 
Output Files Description 
oat.txt  see .txt file 
detail below 

One-at-a-Time parameter index and multiplier values used in sensitivity 
analysis. 

SensAnalysis.txt 
see .txt file detail 
below 

Results of sensitivity analysis for each model run, includes parameter index, 
multiplier value, mean, maximum, and standard deviation of modeled 
streamflow results. 

SArunOutput.txt 
see .txt file detail 
below 

Gives the mean absolute difference of test results over the parameter range 
for each parameter.  The greater the differences, the more sensitive the 
parameter. 

 
 
oat.txt  
parameters 

Description  

Whichparam List of 1 1-20 
       ↓  
 through 20  

For all 20 runs, total of 400 lines. 
 

 

OAT Parameter Value Multiplier values used in sensitivity analysis. 0.0011 – 
495.0495 

 
SensAnalysis.txt 
parameters 

Description Range of 
Values 

whichParam List of 1 1-20 
       ↓  
 through 20  

For all 20 runs, total of 400 lines. 
 

 

OAT Parameter Value Multiplier values used in sensitivity analysis. 0.0011 – 
495.0495 

Max_mod Maximum of modeled streamflow results. 0 – 
3989.274 

Mean_mod Mean of modeled streamflow results. 0 – 
2933.24 

stddev Standard deviation of modeled streamflow results. 0 – 
1149.123 



 

 118

 
SArunOutput.txt 
Parameters 

Description Range of 
Values 

whichparm List of 1 1 - 20 
       ↓  
 through 20   
max_mod The maximum difference of test results over the parameter 

range for each parameter. 
0 – 9.256 

mean_mod The mean difference of test results over the parameter range 
for each parameter 

0 – 6.834 

stddev The standard deviation of test results over the parameter 
range for each parameter. 

0 – 2.705 

 
 
 

3.2 Perform Model Calibration 

The purpose of calibration is to adjust the model parameters so that the model closely matches the 
real system.  Although many GeoSFM model parameters are derived from spatially distributed 
observed data, uncertainties in parameter adjustment to differences in scale, uncertainty in deriving 
the parameter values from observed data, and uncertainties in the structure of the model require that 
parameters be adjusted to overcome what we do not know, and can not measure about the 
watershed.  These issues apply to all hydrologic models. 
  
The calibration process begins with the model setup.  The terrain analysis extracts model parameters 
and creates basin.txt and river.txt watershed attributes.  Next, the user must make an assessment of 
the un-calibrated model.  The best calibration results can only be achieved with realistic parameter 
inputs and an appropriate model structure for the watershed that is being modeled.  The un-
calibrated model results should be analyzed before beginning the calibration.  The program 
dllcaller.exe will call the GeoSFM and run the model one time using the basin.txt and river.txt 
inputs.  The program UncalibStats.exe will report basic model performance statistics using the 
model output and observed streamflow. 
 
For calibration, a subset of the 20 parameters tested in the SA should be selected.  For the 
parameters not selected for calibration, the default ‘uncalibrated’ values in the watershed attribute 
files are used.  The program RunMOSCEM.exe is the main calibration program.  Although there are 
many calibration algorithms that have been developed for hydrologic modeling over the years, the 
MOSCEM algorithm has been chosen for its ability to consistently find optimum parameter sets 
with the least amount of model runs.  The range of model runs will generally be on the order of 
5000 -10000 model runs necessary to converge to a global minimum.  The parameter values that 
created the best model results are retained.  The program MOSCEMpostprc.exe is used to post-
process the calibration results, or rerun the model using the best parameter values so that the 
streamflow results can be plotted and analyzed. 
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Input Parameters Description 
Observed 
Streamflow Stations 

The streamflow station Id displayed in a drop down list.  Selected 1 for 
exercise 4. 

Basin ID for 
Streamflow Station 

Drop down list of basin Ids, select Id that corresponds with the streamflow 
station selected.  In exercise 4 selected 140. 

Number of Runs Drop down list of choices.  Selected 54 for exercise 4. (Selected for faster 
processing time.) 
The number of model runs depends on the length of streamflow record, 
number of parameters being tested, and the complexity of the parameter 
dependent model response for the watershed being modeled. The range will 
generally be on the order of 5000 -10,000 model runs necessary to converge 
to a global minimum. 

Objective Function 
Type 

Convergence can be measured: 
Root Mean Square Error (RMSE) 
Standard Deviation (STD) 
Maximum Likelihood Error (MLE) 
Nash-Sutcliffe Efficiency (NSE) 
Number of Sign Changes (NSC) 
BIAS 
Selected RMSE for exercise 4. 

 
 
Parameters to be Calibrated 
Parameter Description 
SoilWhc Soil water holding capacity 
Depth Total soil depth 
Texture Soil texture: 1=sand, 2=loam, 3=clay, 5=water 
Ks Saturated hydraulic conductivity 
Interflow Interflow storage residence time 
HSlope Average sub-basin slope 
Baseflow Baseflow reservoir residence time 
CurveNum SCS runoff curve number 
MaxCover Permanently impervious cover fraction 
BasinLoss Fraction of soil water infiltrating to ground water 
PanCoeff Pan coefficient for correcting PET readings 
TopSoil Fraction of soil layer that is hydrologically active 
RainCalc Excess rainfall mode 1=Philip, 2=SCS, 3=BucketModel 
RivRough River Channel Roughness Coefficient (Manning n) 
RivSlope Average slope of the river 
RivWidth Average channel width 
RivLoss Fraction of flow lost within the river channel 
RivFPLoss Fraction of the river flow lost in floodplain 
Celerity Flood wave celerity 
Diffusion Flow attenuation coefficient 
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Input Files Description 
balparam.txt 
see section 2.2 

File containing: Number of ordinates of unit hydrograph response, number 
of simulation time steps, simulation start year/day, and number of 
catchments, simulation interval in hours, data format, model initialization 
code, and initial soil fraction. 

basin_original.txt  
see section 1.3 

Original basin characteristics. 

basin.txt  see section 
1.3 

File containing each sub-basin characteristics.  This file is rewritten during 
the sensitivity analysis process. 

river_original.txt  
see section 1.3 

Original river characteristics. 

river.txt  see section 
1.3 

File containing river characteristics.  This file is rewritten during the 
sensitivity analysis process. 

streamflow.txt  see 
.txt detail in section 
3.2 

Streamflow file contains a time series of velocity values in cubic meters per 
second for each sub-basin. 

parameter.in 
see file detail below 

Range of multiplier values used to define parameter search space: 
Minparameter.in = Minrange.txt / (basin ave param) 
Maxparameter.in = Maxrange.txt / (basin ave param) 

moscem.in  see file 
detail below 

Main calibration algorithm control file. 

MOSCEMx.txt  see 
.txt file detail below 

File listing which parameters to calibrate. 

moscem_param.txt 
see .txt detail in 
section 4.1 

Calibration control file. 

ObjOptFlag.in  see 
file detail below 

Flag for number of fluxes to “multi”-calibrate. 

whichModel.txt  see 
.txt detail in section 
4.1 

Sets choice of water balance and routing models. 

observed_streamflo
w.txt see .txt file 
detail below 

Observations from which to compare model results. 

 
 
 
parameter.in Description Unit Range 

of 
Values 

No Index  1 - 20 
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Name Parameter name see “Parameters to be Calibrated”   
Default Dummy variable  1 
Lower Minimum multiplier value  0.001 – 

2.222 
Upper Maximum multiplier value  0.234 – 

495.049 
OptIdx Optimization flag: 0 = do not optimize, 1 = optimize  0,1 
Description Description of parameter see “Parameters to be 

Calibrated” 
  

 
 
moscem.in Parameter Description Values 
No Header nOptPar Number of parameters used for 

optimization. 
6 

 nOptObj Number of fluxes used for 
optimization. 

1 

 nSamples Number of random samples from 
nOptPar dimensioned parameter 
space per shuffle. 

54 

 nComplex Number of complexes. 3 
 nMaxDraw Maximum number of function 

evaluations/model runs. 
54 

 ParamMult file Name of the parameter file 
including path 

D:\GeoSFM\workspace\ 
parameter.in 
 

 whichFlux file Name of the file specifying which 
fluxes to be calibrated, including 
path. 

D:\GeoSFM\workspace\ 
objoptflag.in 
 

 Observed 
streamflow file 

Name of the file providing 
evaluation data, including path. 

D:\GeoSFM\workspace\ 
observed_streamflow.txt
 

 ObjectiveResults 
output 

Name of file storing the parameter 
values of the final points, 
including path. 

D:\GeoSFM\workspace\ 
objectives.out 
 

 Parameter 
values output 

Name of file storing the objective 
function values of the final points, 
including path. 

D:\GeoSFM\workspace\ 
parameter_values.out 
 

 Parameter 
convergence 
output 

Name of the file keeping track of 
the convergences of each of the 
parameters, including path. 

D:\GeoSFM\workspace\ 
par_convergence.out 
 

 
 
MOSCEMx.txt Description Value 
Parameter Index One line for each parameter to be calibrated. 1 - 20 
 ↓  
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 Last line setting to denote end of life. -999 
 
 
 
 
ObjOptFlag.in  
Example of two fluxes –multi-objective                      
No Header Description Value 
 Runoff_1 1 
   Runoff_2 1 
 
Example of one flux –single-objective 
No Header Description Value 
 Runoff_1 1 
   Runoff_2 0 
 
See section 4.2.1 for instructions on creating an observed_streamflow.txt file. 
observed_streamflow.txt Description Value 
Time Date – example 1999001 – format yyyyddd    
                                 ↓  
 Date                   1999365  
Streamflow Stations Streamflow values 0.542 – 

353.646 
       ↓   
Last station   
 
 
 
Output Files Description 
Par_convergence.out  see 
file detail below 

Parameter convergence for best nSamples. 

Objectives.out  see file 
detail below 

Parameter_values for best nSamples. 

Parameter_values.out  see 
file detail below 

Objective function results for best nSamples. 

 
  
Par_convergence.out   
No data written to file   
 
 
Objectives.out Description Value 
nSampleIndex Sample number starting with 1 1 - 60 
           ↓  
 Last sample 60  
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Objective values for each 
flux 

Parameter_values for best nSamples 1058.466 – 
4453.49 

Fitness/Probability for 
each sample 

 0 

 
Parameter_values.out   
No data written to file   
 
 
Post-processing  
Input Files Description 
balparam.txt 
see section 2.2 

File containing: Number of ordinates of unit hydrograph response, number 
of simulation time steps, simulation start year/day, and number of 
catchments, simulation interval in hours, data format, model initialization 
code, and initial soil fraction. 

basin_original.txt 
see section 1.3 

Original basin characteristics. 

basin.txt  see section 
1.3 

File containing each sub-basin characteristics.  This file is rewritten during 
the sensitivity analysis process. 

river_original.txt see 
section 1.3 

Original river characteristics. 

river.txt see section 
1.3 

File containing river characteristics.  This file is rewritten during the 
sensitivity analysis process. 

postproc.in  see file 
detail below 

File containing nSamples, observed streamflow values, 
Parameter_values.out, Objectives.out, Timeseries.out, ObjectStats.out and 
Trdoff_bounds.out. 

 
 
postproc.in Parameter Description Default  
No Header nSamples Same nSamples from moscem.in, 

equivalent to number of parameter 
sets saved in parameter_values.out 

 

  Observed values Observed_streamflow.txt 
  Parameter value output file from 

calibration 
Parameter_values.out 

  Objective function results output file 
from calibration 

Objectives.out 

  Timestep, Observed Streamflow, 
Single timeseries of “best” calibration 
run 

Timeseries.out 

  Objective Statistics for all six 
objective functions for the streamflow 
runs presented in timeseries.out 

ObjectStats.out 

  Timestep, Lower boundary, upper 
boundary, and average streamflow 
over the nSample model runs 

Trdoff_bounds.out 
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Post-Processing  
Output Files Description 
timeseries.out  see 
file detail below 

Objective function results output file from calibration. 

objectiveStats.out  
see file detail below 

All statistic tests from “best” calibration run in timeseries.out. 

Trdoff_bounds.out  
see file detail below 

Timestep, lower boundary, upper boundary, and average streamflow over 
the nSample model runs. 

 
 
timeseries.out Description  
Timestep Date         1  1 - 365 
                 ↓  
 Date       365  
Observed Station 1 Observed Streamflow values.  38.23 – 

963.21 
Calibrated Station 1 Single time series of “best” calibration run. 22.65 – 

10109.30 
 
 
objectiveStats.out Description  
No data written to file   
   
   
   
   
 
 
trdoff_bounds.out Description  
Timestep Date         1  1 - 365 
                 ↓  
 Date       365  
LowerBound Station1 Lower boundary streamflow 

values for station 1. 
12.06 – 2906.70 

UppBound Station1 Upper boundary streamflow 
values for station 1. 

61.05 – 41697.60 

Average Station1 Average streamflow values for 
station 1. 

25.13 – 9196.44 
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3.2.1 Creating Observed Streamflow File 

To complete the calibration process you will need observed streamflow data in a format the same as 
the file below.  The first column header is Time, with a time series of days formatted yyyyddd 
populating column “A”. The rest of the header information is the streamflow gauge IDs. In your 
example two different streamflow gauges are used labeled 1 and 2. These columns are populated 
with the observed stream flow values.  Create your file using Excel.  Copy and paste your 
streamflow data into the Excel file. 
 
To save the file select File and Save As…  
File name: “observed_streamflow.txt” 
Save as type: CSV (Comma delimited) (*.csv) 

 
  
Observed_streamflow.txt example 

 
 
You now have a file that will be used in the Calibration process. 
 

4.0 Post-Processing 

 

4.1 Update Bankfull and Flow Statistics 

 
At the end of a simulation run, the user often wants to compute a summary of the results. GeoSFM 
includes a tool for computing a variety of flow statistics including the maximum, minimum, mean, 
standard deviation, median, 25th, 33rd, 66th, and 75th percentile flows for each catchment.  The 
results of the flow statistics computations are stored in the form of tables which are linked to the 
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catchment data layer.  The user can access the values for each catchment by clicking on the 
catchment in the visual interface or by modifying the legend of the associated data layer in the 
visual interface to display the computed values. 
 
 
Input Files Description 
streamflow.txt  see .txt 
detail section 2.3 

Stream flow file contains a time series of velocity values in 
cubic meters per second for each sub-basin. 

 
  
 

4.1.1 Flow Statistics Outputs 

 
Output Files Description 
monthlyflow.txt see .txt 
detail below 

Stream flow file contains a monthly time series of velocity 
values in cubic meters per second for each sub-basin. 

annualflow.txt  see .txt 
detail below 

Stream flow file contains an annual time series of velocity 
values in cubic meters per second for each sub-basin. 

riverstats.txt  see .txt detail 
below 

List of stream flow statistic types and corresponding 
values. 

statsparam.txt see .txt detail 
below 

 

logfilestats.txt see .txt detail 
below 

 

Table 1  see table detail 
below 

 

 
 
monthlyflow.txt Description Units Range of 

Values 
Time Date – example 199901 – format 

yyyymm (year, month) 
  

BasinID of sub-
basin beginning 
with the most 
downstream 

Stream flow file contains a monthly 
total time series of velocity values in 
cubic meters per second for each sub-
basin. 

m³/s 8.266 – 
1471.28 

↓    
Most upstream sub-
basin 
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annualflow.txt Description Units Range of 
Values 

Time Date – example 1999 –year     
BasinID of sub-
basin beginning 
with the most 
downstream 

Stream flow file contains an annual 
total time series of velocity values in 
cubic meters per second for each sub-
basin. 

m³/s 8.266 – 
1471.28 

↓    
Most upstream sub-
basin 

   

 
 
riverstats.txt Description Units Range of 

Values 
Id File record number  1 - 415 
Gridcode Sub-basin ID number  1- 366 
Soilwater Soil water value for sub-basin  8.3 – 84.7 
Currentsw Current soil water value (same as 

Soilwater) for sub-basin 
 8.3 – 84.7 

Sum   0 
Count Number of days  13 
Mean Stream flow mean value for sub-basin  1 – 983.6 
Maximum Stream flow maximum value for sub-

basin 
 4.4 – 

1471.3 
Minimum Stream flow minimum value for sub-

basin 
 0.1 – 396.2 

Range Stream flow range value for sub-basin  4.3 – 
1141.6 

Variance Stream flow variance value for sub-
basin 

 1.6 – 
174152.3 

Stddev Stream flow standard variation value 
for sub-basin 

 1.3 – 417.3 

Median Stream flow median value for sub-
basin 

 0.1 – 
1034.4 

Quart25   0.1 – 728.4 
Quart75   0.4 – 

1226.4 
Quart33   0.1 – 794.8 
Quart66   0.1 – 

1034.4 
Highflow Stream flow high flow value for sub-

basin 
 2.1 - 1203 

Lowflow Stream flow low flow value for sub-
basin 

 1 – 31.4 

Medflow Stream flow medium flow value for  1 – 983.6 
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sub-basin 
 
 
 
statsparam.txt Description 
No header 1999 
 1 
 1 
 1999 
 13 
 365 
 Max 
 C:\GeoSFM\workspace\streamflow.txt 
 C:\GeoSFM\workspace\monthlyflow.txt 
 C:\GeoSFM\workspace\annualflow.txt 
 
 
 
logfilestats.txt Description Units 
 Start Year=1999  
 Start Day=1  
 Number of Records=13  
 Number of Fields=365  
 Operation (0-MEAN, 1-MEDIAN, 2-MAX) = 2  
 Input filename 

C:\GeoSFM\workspace\streamflow.txt 
 

 Monthly Output filename 
C:\GeoSFM\workspace\monthlyflow.txt 

 

 Annual Output filename 
C:\GeoSFM\workspace\annualflow.txt 

 

 Calculating monthly max for month 1  
   
 Writing annual values  
 
 

4.2 Display Flow Percentile Map 

 
Visual maps are considerably easier to interpret than tabular time series data particularly when 
dealing with large river basins. GeoSFM contains a tool for displaying the results of simulations for 
any given date in a visual map. The stream flow values on a user-selected date are presented in the 
form of indices which present the values in the context of predefined criteria. The default criterion 



 

 129

for differentiating between low and normal flow is the 33rd percentile flow for the analysis period, 
while the 66th percentile flow is the minimum threshold separating normal flow and high flows. 
However, the user can define other criteria such as return period flow or predetermined drought and 
flood warning levels for the classification of flows. Each catchment is assigned a flow status index 
of 1, 2 or 3 to signify the respective low, normal and high flow conditions. A color-coded map is 
then produced showing the flow status of each catchment for the select day. 
 
Input File Description 
streamflow.txt  see .txt 
detail in section 3.2 

Stream flow file contains a time series of velocity values in 
cubic meters per second for each sub-basin. 

 
 
Additional Input Parameters 
Input Parameter Description Units 
Date Selected from drop-down list of dates for 

flow percentile map  --yyyyddd –Julian day 
 

 

4.2.1 Flow Condition Output 

 
Output Description 
Map Map showing daily variation of stream flow values 

displayed as low, normal and high conditions 
 
 

4.3 Display Flow Hydrographs 

 
GeoSFM contains a graphing tool for plotting hydrographs at the completion of a simulation run. 
The tool can be activated from either a program menu or the tool menu bar. The user can then 
visually select the catchment for which a hydrograph is required by clicking on the catchment in the 
visual interface. The program automatically matches the spatial information with the time series and 
produces a hydrograph. The flexibility of this tool is limited by ArcView’s rather limited charting 
capabilities. The user is consequently encouraged to import the ACSII files resulting to flow 
simulations into spreadsheet programs such as Microsoft’s Excel for more sophisticated time series 
plotting capabilities.  
 
Input Parameters Description 
Basin Theme Drop down list of choices – basply.shp selected 
Sub-basin ID  Drop down list of choices –Gridcode selected 
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4.3.1 Hydrograph Outputs 

 
Output Description 
Hydrograph Graph showing daily variation of stream flow at the outlet 

of the selected sub-basin 
 
GeoSFM Utilities 

5.0 GeoSFM Utilities –Raindata  

 
The GeoSFM Utilities Raindata section consists of three steps for processing rain/evap data.  The 
first step is to download the rain/evap data from the FTP site.  The second step is to prepare the data 
for analysis by unzipping, untarring and converting image files to grids.  The last step in preparing 
the rain/evap data is to change the projection from geographic to Lambert Azimuthal. 
 
 

5.1 Downloading Rain/Evap Grid 

 
Input Parameters Description 
FTP Site 
Information 

FTP Site Location  default-edcftp.cr.usgs.gov  

 Site User Name  default -anonymous 
 Site Password   default –anonymous@edc 
Specify Type of 
Data to Download 

Options: Get Rainfall Grids, Get Foredast Rainfall Grids, Get 
Global Pet Grids, and Get Global TRMM Rainfall Grids –
selections made for exercise six are in bold 

Region of Analysis Options: Global, Africa, SE Asia, Afghanistan, Australia, 
NAmerica, CAmerica, SAmerica, and Europe –selected Africa for 
exercise six  -data is not available for all regions 

Select Grids to 
downloaded 

 A list of sixteen days of data is presented –ten days were selected 
to complete exercise six  
–rain_yyyyddd.tar.gz or evap_yyyyddd.tar.gz  

 
 

5.1.1 Available Data 

Sixteen days of data are available for downloading from the FTP site.     
 
The best data currently available by region for rain data: 
. 



 

 131

Global – TRMM (Tropical Rainfall Measuring Mission) 
File naming convention –TRMMYYMMDD*g –TRMM, YY (year), MM (month), DD 
(day) 
*g at the end of the file name if the data is in geographic projection 

Afghanistan – no data 
South East Asia –RFE (rainfall estimates)  

File naming convention -Rain_YYYYDDD*g –Rain_YYYY (year), DDD (Julian Day) 
*g at the end of the file name if the data is in geographic projection 

Australia – TRMM (Tropical Rainfall Measuring Mission) 
File naming convention –TRMMYYMMDD*g –TRMM, YY (year), MM (month), DD 
(day) 
*g at the end of the file name if the data is in geographic projection 

North America –TRMM (Tropical Rainfall Measuring Mission) 
File naming convention –TRMMYYMMDD*g –TRMM, YY (year), MM (month), DD 
(day) 
*g at the end of the file name if the data is in geographic projection 

South America –TRMM (Tropical Rainfall Measuring Mission) 
File naming convention –TRMMYYMMDD*g –TRMM, YY (year), MM (month), DD 
(day) 
*g at the end of the file name if the data is in geographic projection 

Europe – TRMM (Tropical Rainfall Measuring Mission) 
File naming convention –TRMMYYMMDD*g –TRMM, YY (year), MM (month), DD 
(day) 
*g at the end of the file name if the data is in geographic projection 

Africa – RFE (rainfall estimates)  
File naming convention -Rain_YYYYDDD*g –Rain_YYYY (year), DDD (Julian Day) 
*g at the end of the file name if the data is in geographic projection 

Central America –no data 
 
 
The best data currently available by region for PET (Potential Evapotranspiration) data: 
 
Global –PET (global) 

File naming convention -Evap_yyyyddd*g (global) –Evap_YYYY (year), DDD (Julian 
Day) 
*g at the end of the file name if the data is in geographic projection 

Afghanistan – PET (global) 
File naming convention -Evap_yyyyddd*g (global) –Evap_YYYY (year), DDD (Julian 
Day) 
*g at the end of the file name if the data is in geographic projection 

South East Asia – PET (global) 
File naming convention -Evap_yyyyddd*g (global) –Evap_YYYY (year), DDD (Julian 
Day) 
*g at the end of the file name if the data is in geographic projection 

Australia – PET (global) 
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File naming convention -Evap_yyyyddd*g (global) –Evap_YYYY (year), DDD (Julian 
Day) 
*g at the end of the file name if the data is in geographic projection 

North America – PET (global) 
File naming convention -Evap_yyyyddd*g (global) –Evap_YYYY (year), DDD (Julian 
Day) 
*g at the end of the file name if the data is in geographic projection 

South America – PET (global) 
File naming convention -Evap_yyyyddd*g (global) –Evap_YYYY (year), DDD (Julian 
Day) 
*g at the end of the file name if the data is in geographic projection 

Europe – PET (global) 
File naming convention -Evap_yyyyddd*g (global) –Evap_YYYY (year), DDD (Julian 
Day) 
*g at the end of the file name if the data is in geographic projection 

Africa – PET  
File naming convention -Evap_yyyyddd*g (African continent) –Evap_YYYY (year), DDD 
(Julian Day) 
*g at the end of the file name if the data is in geographic projection 

Central America – PET (global) 
File naming convention -Evap_yyyyddd*g (global) –Evap_YYYY (year), DDD (Julian 
Day) 
*g at the end of the file name if the data is in geographic projection 

 
 

5.1.2 Rain/Evap Zip File Outputs 

 
Rain/Evap Output Data 
Zip File Description Unit 
rain_yyyyddd.tar.gz Zip rainfall data downloaded to local working 

directory –one file per day 
mm 

evap_yyyyddd.tar.gz Zip evap data downloaded to local working 
directory –one file per day 

tenths of 
mm 

 
 

5.2 Unzip, Untar, Imagegrid  

 
Rainfall/Evap Input Grids 
Input Grid Description 
rain_yyyyddd.tar.gz Zip rainfall data downloaded to local working directory –one file 

per day 
evap_yyyyddd.tar.gz Zip evap data downloaded to local working directory –one file per 
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day 
 
 
Unzipped Output Grids 
.bil grids Description 
 
 

Unzipped rainfall image files processes in local working directory 

evap_yyyyddd.bil Unzipped evap image files processes in local working directory 
 
Image Files converted to Grids 
Output Grid Description 
rain_yyyydddg Grid containing rainfall data for each day –geographic projection, 

added to ArcView table of contents 
evap_yyyydddg Grid containing evap data for each day –geographic projection 

added to ArcView table of contents 
 
 

5.3 ProjectGrid Geo to Lambert Azimuthal 

 
Rainfall/Evap Input Grids  
Input Grid Description 
rain_yyyydddg Grid containing rainfall data for each day –geographic projection, 

added to ArcView table of contents 
evap_yyyydddg Grid containing evap data for each day –geographic projection 

added to ArcView table of contents 
 
 
Input Parameters Description Unit 
Select Continent for 
Analysis 

Options: Global, Africa, SE Asia, Afghanistan, 
Australia, NAmerica, CAmerica, SAmerica, and 
Europe –selected Africa for exercise six   

 

Analysis Properties AnalysisExtent: Current Value 
Analysis Cell Size: Current Value 
Use all default values 

 

Projection Lambert Equal-Area Azimuthal  
 
 

5.3.1 Projected Outputs 

 
Rainfall/Evap Output Grids 
Output Grid Description Unit 
rain_yyyyddd Grid containing rainfall data for each day –Lambert mm 
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Azimuthal projection added to ArcView table of 
contents 

Evap_yyyyddd Grid containing evap data for each day –Lambert 
Azimuthal projection added to ArcView table of 
contents 

tenths of 
mm 

 
 

6.0 GeoSFM Utilities –GIS Tools 

 

6.1 Compute Rain/Evap Grid Statistics 

 
Because input precipitation data are spatial distributed, it is often difficult to fully discern the 
evolution of rainfall events over time. Precipitation and evapotranspiration data may also be 
required for longer accumulation periods such as dekadal and monthly totals. GeoSFM includes for 
vertically integrating grid layers to perform pixel level accumulations and other temporal statistics 
such as maxima, minima, standard deviations, medians, modes, variety, range and non-zero values 
for each pixel. The results of these analyses are presented as grids. While not directly related to the 
computation of stream flow, the spatial statistic routines are very useful for running verification 
checks on input data and for studying sources anomalously with high stream flow or soil water 
levels in simulation results.  
 
 
Rain/Evap Input Data 
Input Parameters Description Unit 
raindata Rain data from directory mm 
evapdata Evap data from directory mm*10 
Start Year Start year of data --1999  
End Year End year of data --1999  
Start Day Number Start day of data –defaults 1-Julian  Day  
End Day Number End day of data –number of days included for 

calculation of statistics –defaults 365-entered 10 
(shorter processing time) –Julian Day  

 

 
Type of Statistics to be Computed 
Input Parameter Description Unit 
GRID_STATYPE_SUM Sum of values for date range  
GRID_STATYPE_MAX Maximum value for date range  
GRID_STATYPE_MEAN Average of values for date range  
GRID_STATYPE_STD Standard Deviation value for date range  
GRID_STATYPE_MEDIAN Median value for date range  
GRID_STATYPE_RANGE Range of values for date range  
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GRID_STATYPE_MIN Minimum value for date range  
GRID_STATYPE_MAJORITY Majority value for date range  
GRID_STATYPE_MINORITY Minority value for date range  
GRID_STATYPE_VARIETY Number of different values for date range  
GRID_NONZERO_VALUES Non-zero values for date range  
 
 

6.1.1 Rain/Evap Statistical Output Grids 

 
Output Grid Description Unit 
R10SUM1-grid 
name depends on 
type and number of 
days selected 

R=rain, 10=number of days, SUM=statistical type, 
1=each calculation is incremented 

 

E10SUM1-grid 
name depends on 
type and number of 
days selected 

E=evap, 10=number of days, SUM=statistical type, 
1=each calculation is incremented 

 

 
 

6.2 Pick Grid Values at Point 

 
One function within the GeoSFM utility tool is to pick grid values at points.  These points could be 
rain gauge stations within a basin.  In some areas these rain gauge data are not available but, if 
available, ground data can be converted from polygon data to point data. Through the use of this 
functionality, we can compare the rainfall/evap values gathered using satellite products, with 
observed data gathered from rain gauge stations.   
 
Input Station Gauge Data 
Point theme Description Unit 
gauges2.shp Site IDs, latitude and longitude coordinates in 

decimal degrees  
 

 
 
Rain/Evap Input Data 
Input Parameters Description Unit 
raindata Rain data from directory mm 
evapdata Evap data from directory mm*10 
Start Year Start year of data --1999  
End Year End year of data --1999  
Start Day Number Start day of data –defaults 1-Julian  Day  
End Day Number End day of data –number of days included for  
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calculation of statistics –defaults 365-entered 10 
(shorter processing time) –Julian Day  

 
 
 

6.2.1 Rain/Evap Point Outputs 

 
Output File Description 
rainpoint.txt see .txt detail 
below 

File containing time step rainfall (mm) for each station ID 
(per day) 

evappoint.txt see .txt detail 
below 

File containing time step PET (tenths of mm) for each 
station ID (per day)File  

 
rainpoint.txt Description Unit Range of 

Values 
Time Date – example 1999001 -- format 

yyyyddd   
  

                                 ↓   
 Date                   1999010   
    
Station ID number 
starting with the 
smallest number 

Time step rain for each point (rain 
gauge station) 
 

mm 0-16 

           ↓    
Largest number    
 
 
evappoint.txt Description Unit Range of 

Values 
Time Date – example 1999001 -- format 

yyyyddd   
  

                                 ↓   
 Date                   1999010   
    
Station ID number 
starting with the 
smallest number 

Time step PET for each point (evap 
gauge station) 
 

Tenths of 
mm 

33-64 

           ↓    
Largest number    
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6.3 Interpolate Station Data to Grid 

 
For areas over which spatially distributed precipitation data is not available, data interpolation 
routines are provided for converting station readings into a continuous surface.  The routines 
include inverse distance weighting, spline and kriging interpolation methods. 
Input Shapefile Description 
gauges2.shp Site IDs, latitude and longitude coordinates in decimal degrees  
Limpbas.shp Shapefile defining modeled basin region  
 
Point Data 
Input Files Description 
rainstations.txt  see 
.txt detail below 

File containing time step rainfall (mm) for each station ID 

evapstations.txt see 
.txt detail below 

File containing time step PET (tenths of mm) for each station ID 

 
 
 
Parameters 
Input Parameters Description Unit 
Date Data start date formatted m/d/yyyy  
Interpolate Surface 
Method 

Two interpolation methods are displayed in the 
drop down list: 
Inverse Distance Weighted (IDW) interpolator 
assumes each input has a local influence that 
diminishes with distance; the points closer to the 
processing cell are given a greater weight.  
Spline interpolator is a general purpose method that 
fits a minimum-curvature surface through the input 
points. 

 

Inverse Distance 
Weighted (IDW) 
parameters 

This is the default interpolation method.  

Z Value Field The field containing the values to be used in the 
interpolation. –Stations_i 

 

 For IDW specify either Nearest Neighbors or a 
Fixed Radius in the interpolation. –defaults 
Nearest Neighbors.  

 

Number of 
Neighbors / Fixed 
Radius 

Number of Neighbors or input points –defaults 12. 
For Fixed Radius enter the radius to search for 
points. 

 

Power Controls the significance of the surrounding points 
on the interpolated value – the lower the number 
the more influence from distance points.  Defaults 2 
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For exercise six changed to 1. 
Barriers A break that limits the search for input points.  

Defaults No Barriers. 
 

Spline Parameters   
Z Value Field The field containing the values to be used in the 

interpolation. –Stations_i 
 

Weight Weight factor  
No: of Points Specifies the number of points to use per region.  
Type Select from drop down list: 

Regularized – a smooth surface 
Tension – tunes the stiffness of the surface 
according to the character of the modeled 
phenomenon. 

 

 

6.3.1. Rain/Evap Sub-basin Outputs 

 
Output Grids Description Unit 
Rain_1999001 Grid showing rainfall values interpolated across 

sub-basins originating from ground station data for 
one day 

mm 

↓   
Rain_1999010 (ten day example)  
Evap_1999001 Grid showing PET values interpolated across sub-

basins originating from ground station data for one 
day 

tenths of 
mm 

↓   
Evap_1999010 (ten day example)  
 
 
 
 

7.0 GeoSFM Utilities –DEM Tools 

 

7.1 Fill Sinks in DEM 

 
The direction and rate of the movement of water over the land surface is influenced very heavily on 
underlying topography. A hydrologically corrected DEM, which is a DEM that is devoid of 
spurious pits that interrupt hydraulic connectivity over the land surface, must be used when running 
the Geospatial Stream Flow Model. These pits are the result of the interpolation procedure used in 
the creation of the DEM.  Once they are removed there will be no breaks within the flow network.  
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If the DEM you are working with has not been corrected than this process will fill the sinks, then 
water will properly transport across the surface. 
 
Input DEM 
Input Grid Description 
DEM Elevation data requiring fill sink process 
 
 

7.1.1 Fill Output 

 
Output DEM 
Output Grid Description 
fill1 Elevation data after fill sink process 
 
 
 

8.0 GeoSFM Utilities –Time Series 

 

8.1 Convert Daily to Monthly and Annual 

 
Computing Flow Statistics 
At the end of a simulation run, the user often wants to compute a summary of the results. GeoSFM 
includes a tool for computing a variety of flow statistics including the maximum, minimum, mean, 
standard deviation, median, 25th, 33rd, 66th, and 75th percentile flows for each catchment.  The 
results of the flow statistics computations are stored in the form of tables which are linked to the 
catchment data layer.  The user can access the values for each catchment by clicking on the 
catchment in the visual interface or by modifying the legend of the associated data layer in the 
visual interface to display the computed values. 
 
 
Input Files Description 
streamflow.txt  see .txt 
detail section 3.2 

Stream flow file contains a time series of velocity values in 
cubic meters per second for each sub-basin. 

 
 
Parameter 
Input Parameter Description 
Statistic to be computed List includes max and mean  -max chosen for exercise 
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8.1.1 Stream Flow Statistics Outputs 

 
Output Stream Flow Statistics 
Output Files Description 
monthlyflow.txt see .txt file 
detail below 

Stream flow file that contains a monthly time series of 
velocity values for each sub-basin. 

annualflow.txt see .txt file 
detail below 

 

statsparam.txt see .txt file 
detail below 

 

 
 
monthlyflow.txt Description Units Range of 

Values 
Time Date – example 199901 – format 

yyyymm (year, month) 
  

BasinID of sub-
basin beginning 
with the most 
downstream 

Stream flow file contains a monthly 
total time series of velocity values in 
cubic meters per second for each sub-
basin. 

m3/s 8.266 – 
1471.28 

↓    
Most upstream sub-
basin 

   

 
 
 
 
 
annualflow.txt Description Units Range of 

Values 
Time Date – example 1999 –year     
BasinID of sub-
basin beginning 
with the most 
downstream 

Stream flow file contains an annual 
total time series of velocity values in 
cubic meters per second for each sub-
basin. 

m3/s 8.266 – 
1471.28 

↓    
Most upstream sub-
basin 

   

 
 
statsparam.txt Description 
No Header 1999 
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 1 
 1 
 1999 
 13 
 365 
 Max 
 C:\GeoSFM\workspace\streamflow.txt 
 C:\GeoSFM\workspace\monthlyflow.txt 
 C:\GeoSFM\workspace\annualflow.txt 
 
 
 

8.2 Compute Daily Characteristic Flows –under development 

8.3 Compute Frequency Distribution 

 
Need to add some text…… 
 
Input File Description 
streamflow.txt  see .txt 
detail section 3.2 

Stream flow file contains a time series of velocity values 
in cubic meters per second for each sub-basin. 

 
 
 
 
Input Parameters 
Input Parameters Description 
Basin coverage/grid theme Selected basply.shp for exercise 
Select statistics to be 
computed 

Selected Total Flow, Mean Flow, Maximum Flow, and 
Minimum Flow for exercise  -multiple choices from a 
drop down list 

Select field to display Selected Mean for exercise –multiple choices from a drop 
down list 

 
 
 

8.3.1 Distribution Outputs 

 
Output Description 
Map Map showing daily variation of stream flow values 

displayed as selected statistic –for the exercise Mean was 
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selected  --multiple choices are presented in drop down list 
 
Output flow.avl ??? 
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